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We can all find new ways of 
doing something in Windows. 
Quite often you’ll discover a new 
tip that will change the way 
you’ve been working for years, 
and saves you time every time 
you do it. This month’s main 
feature, starting on page 12, has 
100 of these essential tips for you 
– we guarantee it will improve 
your PC life! This feature is 
dedicated to Windows 8.1, but, 
don’t worry, a lot of the tips still 
apply to older versions of 
Windows, including Windows 7.

Another unmissable feature  
this issue looks at how to survive 
being the go-to person when 
your friends and family are 
having trouble with their PC. See 
page 62 for how to offer the best 
help to those persistent callers 
and keep both them and their 
PCs happy.

We also have the latest news, 
views and reviews, as well as 
some great tutorials to help 
you get the best out of 
your Windows PC. Until 
next time!

Welcome

SUBSCRIBE TO THE MAG TODAY AND 
SAVE - JUST TURN TO PAGE 32!

We pride ourselves in being the only magazine 
on the shelves to show you exactly how to get 
the best from the Windows operating system, 
whether it’s Windows 7 or Windows 8.1. 
Windows  Help & Advice also comes with a disc, 
on which you can find some of the great apps 
covered in the magazine. If you get a chance, 
take a look at how you can even read the 
magazine on your laptop, phone or tablet.
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6 Discover A look at the internet of 
things, OneDrive cloud storage and more

32 Subscriptions Save up to 44%  
on print and digital issues
 
37 Back issues Don’t miss out! Order 
past issues while stocks last
 
98 Next month Discover what’s 
coming up in the next issue

72 Four pages of essential 
expert help for all your 
tricky technical queries
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12 Windows 8.1 power tips 
get more from the new Windows release 
with these 100 quick but useful tweaks

58 Free media players
We look at the 10 best alternatives  
to Windows Media player
 
62 How to be a tech guru 
luis Villazon reveals his top tech secrets – 
so you can fix everyone else’s problems
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26 learn how to capture  
your pC’s screen with picpick

30 give your favourite  
photos a vintage look

34 Keep vulnerable software  
up to date with Heimdal

38 Solve common OneDrive 
problems with a few clicks

40 explore the starry cosmos  
with WorldWide telescope

44 Access gmail messages in  
the Windows Mail app

46 Build a great website  
with Website X5 Home 11

50 learn how to fix hardware 
problems quickly and easily

54 turn yourself into a detective 
and rid your pC of malware

Your guide Graham Barlow says…
“each month we include as wide a range of tutorials 
as possible, to help you use your computer more 
efficiently and inspire you to try new things”

eXplORe  
The best PC tutorials
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Tidal .Wav Jay Z’s got 
99 problems, but the 
fidelity of his streaming 
service ain’t one
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The Knowledge…

YouTube, Google’s streaming video 
service, is a neat alternative to paid-for 
subscription services. Not only does it 
contain almost every piece of music you 
can think of, often with accompanying 
video, but it’s free. The website recently 
realised it could be a good music platform 
unto itself, and launched its Music tab. A 
subscription service is coming later this 
year, but for now you can make the most  
of its content and find the music you love.

How to get access to a 
huge music collection

Soundtrack your life

Y
ou know that geek has hit the 
mainstream when a piece of 
software gets endorsed by Jay Z, 
Rihanna, Kanye West and 

Madonna. They’re some of the megastars 
behind Tidal, a streaming service which 
promises high-quality tunes and fairer  
pay for its artists.

Tidal isn’t the only music streaming 
service, and paying for a monthly 
subscription rather than individual 
downloads has 
become the dominant 
way to get music. It 
makes sense – why 
spend £120 a year on 
12 albums, when you 
can spend the same on unlimited music?

Spotify is the market leader in this area. 
For £10 a month you can access its vast 
repository of albums, which has recently 
added music legends Pink Floyd and Led 
Zeppelin’s back catalogues. We’ve also 
found that obscure music is available on 
the service that isn’t available elsewhere.

Tidal’s basic service is also £10 a month, 
but for £20 you can subscribe to Tidal 

HiFi. This promises lossless sound  
quality, which means the music you listen 
to is indistinguishable from that of the 
quality of a CD. Tidal also benefits from 
curated editorial content, something 
Spotify still hasn’t quite got right, and can 
help you navigate the often choppy waters 
of modern music.

If you already have a huge collection of 
MP3s look no further than Google’s Play 
Music. While you can pay £10 a month for 

a subscription, its 
advantage is you can 
upload up to 50,000 
MP3 files and play 
them via the web  
or its mobile app, 

without spending a penny. 
The great thing about these music 

services is you can flit between them until 
you find something that works for you. 
Spotify’s a great starting point, and 
brilliant for rarer tracks, Tidal pairs well 
with the super-duper HiFi, and Google 
Play Music is perfect if you want the 
advantages of both a large MP3 collection 
and a streaming music service.

the new, artist-backed tidal means music fans now  
have three good streaming services to choose from

Microsoft Surface 3
So, um, what’s surfaced here then?
Groan. I’ll pretend you didn’t just make 
that terrible joke. The Surface 3 is 
Microsoft’s latest attempt to crack both 
the laptop and tablet market in one fell 
swoop. Like its predecessors, the Surface  
3 functions as both, with a handy 
magnetic snap-on keyboard to 
transmogrify it from tablet to laptop.

very nice. So what’s new about this  
one then?
The 10.8-inch display is slightly larger,  
with an HD-plus resolution. Within you’ll 
find an upgraded quad-core processor,  
64 or 128GB of storage and 2 or 4GB of 
system memory. The device is capable of 
driving up to three connected displays, 
too, so you can happily connect it to your 
TV for media playback.

That sounds pretty impressive. is there 
anything else worth mentioning?
According to Microsoft it’s the thinnest 
and lightest Surface ever, which is pretty 
impressive considering how thin and  
light the Surface was anyway. It also 
boasts 10 hours of battery life, and a full 
version of Windows rather than the 
somewhat hobbled RT flavour that 
shipped on earlier Pros.

So what’s the main competition  
for the Surface 3 then?
Apple’s iPad is still Microsoft’s biggest 
competitor in this field, but sales have 
waned recently, dropping 18 per cent in 
the last year. However, Apple is rumoured 
to be launching a more Surface-like iPad 
Pro later this year, which will act more like 
a computer and less like a tablet. 

Okay, i’m sold on it. When can i get a 
Surface and how much is it?
The new Surface is out now, and it’ll set 
you back £420 (64GB storage/2GB RAM)  
or £500 (128GB storage/4GB RAM). 
However, if you want to make the most  
of it you’ll need to buy a Surface Pen (£37) 
and a Type Cover (£100) as well. We 
recommend hunting around for bundle 
deals if you’re really keen.

ChOpin liST Go further down the page and  
you’ll find playlists and all sorts of collections

ROll yOuR OWn Start to create a playlist by 
clicking the plus button underneath a video

hiT paRade Begin by visiting youtube.com/music. 
here you’ll find the uK’s most popular music vids

YouTube MuSic Make the most of music vids

“subscriptions rather 
than downloads is now 
the way to get music”

The Microsoft 
Surface 3: it’s 
even thinner  
and lighter
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Music to your ears
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HENRY WINCHESTER 

TECH EXPERT

Tip of the month Be at OneDrive

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

Programs loading when you turn your PC 
can cause it to boot up slowly, particularly  
if it’s an older model. They often find their 
way into your computer surreptitiously, so  
it can be hard to know what’s got in where, 
but fortunately it’s easy to turn off startup 
programs. Simply open the Start menu and 
type “msconfig.exe” and click the result.  
Now choose the ‘Startup’ tab and you’ll see 
everything that loads when you turn on your 
PC. Untick the boxes next to anything you 
don’t want to load, such as Spotify or 
LibreOffice’s launcher, then choose ‘OK’.  
Next time you switch on your PC it should 
boot a lot more quickly.

Disable Startup 
Programs

Searching for Solitaire or missing 
Minesweeper? Unlike previous versions 
Windows 8 doesn’t come with any of 
Microsoft’s classic games preinstalled, but 
there are graphically upgraded versions 
waiting in the Windows Store. To find them 
press the Start button, choose ‘Games’, and 
search for ‘Microsoft’. You’ll find all the classics, 
such as Minesweeper with a brand-new 
adventure mode, an achievement-enabled 
version of Solitaire, and an overhauled 
Mahjongg. There are also new casual titles, 
such as Treasure Hunt, Jackpot and Bingo.

Get Hold of  
Old GamesWe almost have as many videos as we do 

photos and music files nowadays, but they’re 
neglected in Windows 7’s Start Menu. It’s 
easy to quickly open your videos folder, 
though. Right-click on the Start button and 
then choose ‘Properties’. Choose the Start 
Menu tab and click ‘Customise’. Next you can 
tick ‘Display as a link’ to immediately launch 
the video folder, or ‘Display as a menu’ to 
jump straight to recent files. Here you’ll also 
find options to display photo and music 
folders as menus, so you can access those 
files more quickly as well.

Videos in  
Start Menu

OneDrive is Microsoft’s brilliant cloud 
storage system, which backs up your 
important files and folders online so 
you can access them from anywhere.

It’s baked in to Windows 8.1, but it’s 
also available as an almost-invisible 
addition for Vista, 7 and 8. Visit 
onedrive.live.com and choose 
‘Download’. Next click the ‘Download 
now’ link under OneDrive. Run the 
software, login to your Microsoft 

account, and stick to the default 
settings when asked. 

When you next open Explorer you’ll 
see a new folder entitled ‘OneDrive’ to 
the left. This functions just like a local 
folder on your computer, with the 
added benefit that everything stored 
here is automatically backed up 
online. Now you can visit onedrive.live.
com from mobile devices and access 
content stored in the OneDrive folder.

Get OneDrive on any Windows PC
Painlessly back up important files online with 
Microsoft’s free cloud storage system

In the Cloud With a very useful 15GB of free storage onedrive 
can hold lots of your music and videos to be accessed anywhere
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 I
f you’ve been to a technology store 
recently you’ll notice a proliferation of 
normal items with the word ‘smart’ in 
front of them. Smart TVs, smart 

lightbulbs, smart locks, smart dishwashers 
– the list is nigh-on endless. These Wi-Fi 
connected gizmos are part of a bigger 
movement, dubbed the ‘internet of things’.

The ‘things’ in the phrase can be 
anything from 
security cameras to 
thermostats to cars. 
The only requirement 
is they’re capable of 
being controlled by 
the internet. A smart 
security camera, for 
example, could send 
you a text when it 
detects movement. 
They can also work 
the other way, such as a Wi-Fi coffee 
machine, which can be activated from 
anywhere in the world. 

These may seem like tech novelties, but 
smarter home objects can save you money. 
Hive, the internet-connected thermostat, 
is a clever system that automatically 
detects when you’re within a certain 
distance of your home and heats it to a 
nice temperature for when you walk in 

through the door. The company believes 
this can save you £150 a year.

While it’s useful for the average punter, 
internet of things devices provide an 
additional feedback loop for companies. 
Hive’s stats have shown the average 
person living in Scotland keeps their 
houses at a warmer average temperature 
than someone in Cornwall. Obviously… 

This is just the  
tip of the iceberg, 
though: connected 
cars can send many 
millions of pieces of 
data feedback every 
minute, from the way 
the driver accelerates 
to the way thousands 
of cars take the  
same corner. This 
colossal amount of 

information, termed ‘big data’, could make 
cars safer and more economical.

If you’re interested in the internet of 
things we recommend starting small and 
building up gradually, rather than 
overhauling your house. A Wi-Fi socket, 
for instance, is a cheap way to get into the 
internet of things, while giving you remote 
power control of whatever you plug into it, 
which could be a lamp, TV or dishwasher.

We take a look at the smart new tech that looks likely  
to change our homes, our cars and our lives

Everyone’s talking about…

1What does Facebook 

acquisition Aquila 

specialise in?
A) Credit reports
B) Internet-carrying drones
C) Driverless vehicles

2Google has 
partnered with 

Johnson & Johnson to 

create what?
A) Smart baby powder
B) More Johnsons
C) Surgical instruments

3 Plays.tv is a new 
social network 

targeted at whom?

A) Children
B) VHS fans
C) Gamers

4 Who closed their 
Instagram account, 

complaining they’d been 

“hounded off”?
A) Danny Dyer
B) Katie Hopkins
C) Stephen Fry

5 O2’s rugby-themed 

prototype 
smartphone is made 

from which material?

A) Rugby balls
B) Grass
C) Jockstraps

6 Prisoner Neil Moore 

used what to escape 

from HMP Wandsworth?

A) A drone
B) A fake email
C) A hacked fire alarm

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1B. 2C. 3A. 4C. 5B. 6B.

What is the ‘internet  
of things’ anyway?

Gifprint
gifprint.com

If you ever see a small animation or video 
on the internet chances are it’s a GIF. 
Created by ISP CompuServe in 1987,  
the Graphics Interchange Format is a file 
that can include multiple frames played 
one after the other, creating the illusion  
of movement in much the same way as  
a cinema screen.

The problem is that printing out GIFs 
removes all the animation, so that funny 
video of a cat simply becomes a 
motionless, useless and unfunny picture 
of a cat. Gifprint has found a way around 
this by turning the individual frames into 
a homemade flipbook, a little like the stick 
figures who adorn the corners of many  
a school textbook. If you’re feeling really 
clever you can even create custom ones 
with a small video file and the gif 
converter available at zamzar.com.

Stop motion Bring animations to life in the 
real world with Gifprint

Discover
It’s good to talk
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The processing power of Aurora, a 
supercomputer under 

development by Intel and Cray. The 
floating-point operations per 
second (FLOPS), measures the 

performance of a processor. Aurora 
is a thousand times more powerful 

than your average PC. 

These are the names given to 
two mobile apps, which use your 
device’s camera to livestream 
video onto the internet. 
Periscope has been created by 
Twitter, while Meerkat is 
independent. Periscope currently 
ranks at 22 in social apps, while 
Meerkat comes in at 120.

What are 
PeriscoPe and 
Meerkat?

550,000
Copies of a recent episode 
Game of Thrones were 
illegally downloaded within 
12 hours of its release, 
according to piracy-tracking 
company Excipio. The sword, 
sex and sorcery epic fantasy 
attracts more than 20 million 
legitimate viewers on HBO in 
America and Sky Atlantic in 
the UK, but the delay in 
broadcast between the two 
and its absence from 
terrestrial channels are cited 
as reasons for its high level 
of piracy.

tWo
MiLLion 
The number of smartphones 
Xiaomi shifted in 12 hours. The 
Chinese brand is unheard of in 
the West, but it’s massive in 
Asia. The sales were generated 
by a flash sale targeted at the 
Indian market. India is a tricky 
country for tech manufacturers 
to crack as it requires heat-
resistant phones to cope with 
its climate, as well as more 
intricate language options.

180 
petaFLOpS
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Henry Winchester reveals a host  
of fascinating digital facts



5.2 per cent  
The drop in sales of personal 
computers over the last year. It’s 
not all bad news though – 
Lenovo and HP experienced 
growth, and sales of notebooks, 
hybrid and Windows tablets 
increased. The figures don’t take 
into account Google’s Chrome-
book laptops, which shifted 
5.2 mn units last year. Added 
together it suggests growth…

The web’s original craft market is about to 
celebrate its tenth birthday – it was launched in 
June 2005.

The site makes its money by charging $0.20 for 
each item listed, and a 3.5 per cent fee for sales 
completed on the website.

76 per cent of US Etsy sellers consider their 
virtual shop a business, and almost a third make 
their sole income from the site.

In 2013, its terms of service were tweaked to 
allow manufactured goods. It was a 
controversial move – but it also lead to annual 
sales of more than a billion dollars.

Unusually for a tech company 51 per cent  
of its staff are female – for Facebook it’s just 
15 per cent.

As well as stocking handmade items, Etsy allows 
the sale of vintage articles – as long as they’re 
over 20 years old.

685 Etsy employees are scattered through its 
international offices in locations such as Berlin, 
Dublin, London and Melbourne.

The site has 22 million items for sale,  
ranging from 11p buttons to a £180,000  
giant coffee mug.

Alicia Shaffer is Etsy’s richest seller. The mum-
of-three earns $65,000 a month from 
handmade socks and scarves.

tOp etSY FactS

The amount of hard drive space 
you need to install Grand Theft 
Auto V on your PC. The whopping 
size is down to the extra textures, 
vehicles and characters that make 
the PC version look spectacular, but 
it takes about 19 hours to download 
on an average UK internet 
connection. For comparison Grand 
Theft Auto IV, released in 2008, 
weighs in at just over 30GB, while 
2005’s Grand Theft Auto: San 
Andreas occupies a mere 4.7GB.

65
GB

Discover 
Facts & figures
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seVentY siX
Jobs created by Start-Up New York, a 
program launched to create jobs in 

tech. The aim was 2,000 roles, 
but factors have seen this 

falling short. 



“The tips in this 
feature will 
unravel hidden 
features and 
customisation 
options”



Windows 8.1 
Power User tips

indows 8.1 is a wonderfully 
evolved version of the 
revolutionary Windows 8 
release. It’s a direct result of 
Microsoft paying heed to its 

customers’ feedback and suggestions. 
Windows 8.1 offers an improved user 
experience and better integration with 
Microsoft applications, such as OneDrive 
and Skype for example. 

The original release was criticised for its 
bias toward touch devices. Windows 8.1, 
while still built for touch, now offers a 
better end-user experience to people on 
traditional non-touch devices. For starters, 
you are no longer forced to use the Metro 
interface, as Windows 8.1 boots directly 
into the Desktop view. Other components 
critical to the user experience have also 
been enhanced and have taken on new 
features and functionalities. 

At first glance, Windows 8.1 only looks 
like a touched-up version of the previous 
release. In its quest to minimise changes to 
the default user experience and maintain 
consistency with the previous release, most 
of the new functionality is tucked away 
under the folds. The tips in this feature will 
unravel these hidden features and 
customisation options, and help you 
personalise your Windows 8.1 so it works 
just as you’d like it to. So, with plenty 
of advice at hand, it’s time to dive in! 

Roll up your sleeves with Mayank Sharma 
as he helps you get more out of the latest 
Windows release – with 100 quick tweaks

W

Windows 8.1
100 power user tips



Start screen 
1 Show app notifications 

on the Lock screen
Bring up the Charms bar and go 
to ‘Settings > Change PC settings’. 
Then navigate to ‘Search and apps > 
Notifications’ and toggle the ‘Show app 
notifications switch’ to On, which also 
enables the option to add notifications 
on the Lock screen.
 

2 Play a slideshow on  
the Lock screen

Bring up the Charms bar and head to 
‘Settings > Change PC settings > PC & 
Devices > Lock screen’. Toggle the ‘Play a 
slide show of pictures on the lock screen’  
to On and then select a picture source.

3 Create a new tile group 
Whenever you want to create a 

new group of tiles, drag a tile to the right 
side of the Start screen. When you see a 
separator, drop the tile to its right. Once 
the group is created you can then add as 
many tiles as you would like.

4 Set desktop wallpaper 
for Start screen 

To set wallpaper for the Start screen, first 
of all go to the Charms Bar and then 
head to ‘Settings > Personalise’. This will 

then bring up a list of 15 wallpapers that 
could be used for the Start screen – the 
default Windows desktop wallpaper is the 
last one on the list.

6 Use quiet hours
To turn off notifications during a 

certain time period, head to ‘PC Settings > 
Search and apps > Notification’ and then 
use the drop-down lists to define the period 
of quiet hours you want to use. 

7 Pin people 
Launch the People app and click on 

a contact to view their feed. Next up, right-
click inside the contact and select the ‘Pin to 
Start’ option. The app will let you customise 
the name of the contact, as well as pick a size 
for the tile if you wish.

8 Pin folders
Similarly, you can pin frequently 

visited folders from your local computer or  

9 Add apps 
on the Lock 
screen
Bring up the Charms bar and click on 
‘Settings > Change PC Settings’. Then 
head to ‘PC and Devices’, which 
brings up the settings for the Lock 
screen. Next, scroll down and click  
on one of the greyed-out icons and 
pick the app you want to appear on 
the Lock screen.

5 Move with 
one hand
To simplify the movement of 
items, head to ‘Control Panel > 
Mouse’ and in the Buttons tab, 
toggle the option to turn on 
ClickLock. Then press the Settings 
button and use the slider control 
to set the time required to lock a 
mouse button.
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a network or cloud drive. Just right-click 
on the folder in File Explorer and select 
‘Pin to Start’. When you click the folder, 
it’ll bring you to the desktop and open it.

10 Pin a playlist 
Launch the Music app and click 

on the playlist you wish to add to the 
Start screen. From the icons on the top, 
click on the ‘Pin to Start’ button and 
select the tile size for the playlist.

11 Arrange programs
The down arrow button on the 

Start screen lists all the programs on the 
computer. You can customise the list  
to display frequently used programs  
– do this by using the down arrow next  
to the Apps title and selecting the ‘by 
most used’ option.

12 Reset the Start screen
To reset the Start screen 

to its default layout, navigate to 
‘%LocalAppData%\Microsoft\Windows’ 
and delete the ‘appsFolder.itemdata-ms’ 
and ‘appsFolder.itemdata-ms.bak’ files. 
To apply the changes, launch the Task 
Manager, right-click on the entry for 
Windows Explorer and select ‘Restart’.

13 Display administrative 
tools options

To add Administrative tools to the Apps 
View on the Start screen bring up the 
Charms bar and click on ‘Settings’. Then 
head to the Tiles menu and toggle the 
‘Show administrative tools’ option to ‘Yes’.

14 Enable speech 
recognition at startup

To control your PC with your voice, you’ll 
have to launch the speech recognition 

feature at startup. Head to Control Panel 
> Speech Recognition, click on Advanced 
speech options and toggle the ‘Run 
Speech Recognition at startup’ checkbox.

15 Use an animated 
background

Bring up the Charms bar and head to 
‘Settings > Personalize’. This in turn 
brings up a list of static and animated 
backgrounds, each of which can be 
customised by changing the background 
colour and accents.

16 Disable Hot Corners
Bring up the Charms Bar and 

head to ‘Settings > Change PC settings’. 
Then head to ‘PC and devices > Corners 
and edges’ and set both options present 
in the Corner navigation section to ‘Off’ 
to disable both hot corners.

19 Disable Live Tiles 
altogether

To collectively disable all Live Tiles,  
firstly launch the Group Policy Editor 
and go to ‘User Configuration > 
Administrative Templates > Start Menu 
and Taskbar > Notifications’. Then look 
for the ‘Turn off tile notifications’ and 
double-click on it to set it to Enable. 

20 Add app shortcuts to 
your Start menu 

If you feel that you want to switch to a 
screen similar to the classic Start menu, 
including shortcuts to your apps, firstly, 
right-click the taskbar and then choose 
‘Properties’. Next up you need to switch 
to the Navigation tab, and in the Start 
screen section, toggle the ‘Show the Apps 
view automatically when I go to Start’ 
checkbox. And you’re done.

17 Access 
advanced 
Startup 
screen
Bring up the Charms Bar and click 
on Settings and then click on 
Power button. Now press and hold 
the [Shift] key and click on the 
Restart option. In a few seconds, 
Windows will show you a new 
screen with various options.

18 Pin 
websites
To pin a frequently visited websites 
to the Start screen, open it in the 
Metro version of Internet Explorer. 
Then click the Star favourites icon 
and select the ‘Pin site icon’ and 
choose a tile size for the website.
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Windows 
desktop

21 Bypass the  
sign-in screen

To log straight into Windows, on the 
Start screen type netplwiz to bring up 
the User Accounts window. In the Users 
tab, unselect the ‘Users must enter a 
user name and password to use this 
computer’ option and click OK. 

22 Show folders in your 
navigation panels

To access all the folders on your PC, 
including local ones and network 
locations, launch the File Explorer 
and head to ‘View > Options’. Under 
the General tab scroll down to the 
Navigation pane section and toggle  
the ‘Show all folders’ checkbox,

23 Customise Jump List
Right-click on an app’s icon in the 

taskbar to display its Jump List. To remove 
an item from the list, right-click on it and 
select the ‘Remove from this list’ option. 
Please note: pinned items will have to be 
unpinned before they can be removed.

24 Bring Libraries back
By default, the File Explorer 

doesn’t show the Libraries folders in the 
navigation panel. To bring them back, 
open File Explorer and head to ‘View > 
Options’ and in the General tab toggle 
the ‘Show libraries’ checkbox.

25 Ease desktop navigation 
If you use a mouse and keyboard 

to control the PC, then you should enable 
some hidden conveniences. Right-click 
anywhere on the desktop taskbar and 
select ‘Properties’ from the menu that 
appears. Switch to the Navigation tab 
and toggle any options that appeal.

26 Auto-save screenshots
You no longer need a third-party 

app to take screenshots. Simply use the 
[Windows]+[PrntScr] key combination 
to take the screenshot. It will be 
automatically named and saved in the 
Pictures library as Screenshot.png for you.

27 Create desktop  
shortcuts for apps

Since you can’t drag shortcuts to the 
desktop to create them anymore, 
right click on the desktop and head to 
New > Shortcut instead. Then use the 
Browse button to navigate to the app’s 
executable file, which are usually filed 
under C:\Program Files.

28 Display file extensions
By default Windows hides 

the extensions of known file types. To 
override this behavior, in the File Explorer 
head to ‘View > Option’ and switch to 

the View tab. Here look for the ‘Hide 
extensions for known file types’ and then 
uncheck it.

30 Access all  
Bluetooth devices

To do this, right-click on the desktop 
and go to ‘New > Shortcut’. Instead of 
pointing to a location, type: %windir%\
explorer.exe shell:::{28803F59-3A75-
4058-995F-4EE5503B023C}. This 
creates a folder that houses all connected 
Bluetooth devices. 

31 Display Preview pane  
in File Explorer

To easily preview files, open the File 
Explorer, select the View tab and click on 
the Preview pane option to enable it. Any 
file you select now, will automatically be 
previewed in pane on the right-side of 
the file explorer.

29 Launch 
metro apps 
from desktop
Bring up the run dialog box with 
the [Win]+[R] hotkey combination 
and type shell:AppsFolder. This 
will open a hidden applications 
folder with shortcuts for all 
installed apps, including Metro 
apps, which you can then launch 
from the Desktop view itself.
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32 Quick Access menu
Windows 8.1 includes a hidden 

quick access menu which provides access 
to several system tools. You can bring up 
the menu by using the [Win]+[X] hotkey, 
or right-clicking on the extreme bottom-
left corner of the screen.

33 Disable startup 
programs

To remove unnecessary programs from 
the computer’s startup process, use the 
[Ctrl]+[Shift]+[Esc] hotkeys to launch  
the Task Manager. Then switch to the 
Startup tab and right-click on the 
program you wish to remove, and then 
select the ‘Disable’ option.

34 Disable taskbar preview
If you find taskbar preview 

annoying you can simply disable it. In the 
Run window ([Win]+[R]) enter regedit. 
Go to ‘HKEY_CURRENT_USER > Software’ 
and create a ‘New > DWORD (32-bit) 
Value’. Name this value NoThumbnail 
and set its value as 1.

35 Peek at the desktop
You can use the ‘Peek at Desktop’ 

option to take a look at the desktop 
without having to minimise all open 
windows. To enable it, right-click on the 
bottom-right corner of the taskbar and 
toggle the ‘Peek at Desktop’ checkbox. 

36  Emergency restart
To restart quickly, press the [Ctrl]+ 

[Alt]+[Del] hotkeys and in the screen 
that comes up, press and hold the [Ctrl] 
key and click on the Power button at the 
bottom right corner. This will bring up the 
Emergency Restart option.

37 Include Files/Folders  
in Libraries

To append files/folders to libraries, open 

File Explorer and select the files/folders 
you want to include in a particular library. 
Then go to ‘Home menu > Easy Access > 
Include in Library’ and select the library 
you want to append them to.

39 Shutdown your PC  
with a single click

Do you want a shortcut to quickly 
shutdown your PC with a single click? 
This can be really handy if you need to 
leave your desk in a bit of a hurry. To set 
one up, right-click on the desktop and go 
to ‘New > Shortcut’. In the location field, 
type shutdown.exe -s -t 00 and then 
name the shortcut. You can now use this 
shortcut to power off the PC by simply 
clicking on it. 

38 Map 
OneDrive as a 
network drive
First log in to OneDrive, click on 
Files and copy the unique id 
mentioned in the URL after cid. 
Now open This PC in File Explorer 
and go to ‘Computer > Map 
network drive’. In the folder field 
enter https://d.docs.live.net/ID] 
replacing ID with your unique ID. 

40 Move your 
cursor with 
your keyboard
To move your cursor with your 
keyboard, bring up the Charms bar 
and go to ‘Settings > Change PC 
settings > Ease of Access >Mouse’. 
Toggle the ‘Use numeric keypad to 
move mouse around the screen 
option’ to On. Also, enable the 
option to control speed with the 
[Ctrl] and [Shift] keys.

The Quick Access Menu is Microsoft’s 
way of making up to advanced users 

for removing the Start button
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Windows apps 
41 Control app updates

If you’re on a metered internet 
connection, it’s prudent to turn off 
automatic updates. Launch the Store app 
and then bring up the Charms menu 
and go to ‘Settings > App’ updates. Here, 
change the option ‘Automatically update 
my apps’ to ‘No’.

42 Clear personal info
Before you share your computer 

with someone, you might want to clear 
personal information from app tiles. 
Bring up the Charms bar and go to 
‘Settings > Tiles’. Here, simply click on the 
Clear button under the ‘Clear personal 
info from my tiles’ option.

43 Disable Bing integration
The Smart Search feature sends 

local search queries (i.e. searches on your 
PC) to Bing. To disable this behavior, 
bring up the Charms bar and head to 
‘Settings > Change PC Settings > Search’ 
and apps, and turn the ‘Get search 
suggestions and web results from Bing’ 
option to ‘Off’.

44 Switch to the  
Reading view

To minimise distractions while reading 
an article on the web, the Metro version 
of Internet Explorer includes a useful 

Reading view. To switch to this view, click 
on the Read button next to the address 
bar which appears whenever a page has 
finished loading.

45 Access OneDrive  
files offline

To view the contents of OneDrive without 
being connected to the internet, launch 
the OneDrive app, bring up the Charms 
menu and go to ‘Settings > Options’. 
Here toggle the ‘Access all files offline’ to 
‘On’ and wait for the files to sync.

48 Stop apps from running 
in the background

To close Metro apps without leaving 
traces in the memory, click on top of 
the screen and drag the app to the 
bottom. But instead of leaving the app 
immediately as you might normally  
do, wait for a few seconds until it turns  
its thumbnail from an app preview to  
an icon, then move on. 

49 Control apps  
with gestures

The Food & Drinks app includes a special 
mode to navigate the app with gestures. 
Launch the app, open a recipe and click 
on the ‘Hands-Free mode’ button at the 
bottom. Now wave your hand in front of 
your webcam to flip pages.

50 Remove multiple apps
To uninstall more than one app 

in one go, hold down the [Ctrl] key and 
click on the tiles of the apps you wish to 
remove to select them. Next, right-click 
on any one of the selected tiles and 
choose the ‘Uninstall’ option. 

51 Default to  
desktop apps

Windows 8.1 calls on Metro apps to 
open supported file types. To change 
this, bring up the Charms bar and head 
to ‘Settings > PC Settings > Search and 
apps > Defaults’ and swap out the Metro 
apps with an equivalent desktop app.

46 Disable 
browser  
add-ons
Add-ons can slow Internet 
Explorer and can also be exploited 
to break into your PC. To disable 
them, click on the gear icon on the 
top-right corner and head to 
‘Manage add-ons’. From here you 
can individually disable any 
additional components you like.

47 Rescue  
files with  
File History
To automatically backup copies of 
files in your Libraries, type history 
on the Start screen and select ‘File 
History Settings’. Connect an 
external drive and turn on the ‘File 
History’ feature. Windows will now 
save copies of files every hour.
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Windows apps 52 Remove unused  
wireless networks

To forget old wireless networks, launch 
the Command Prompt as Admin. The 
command netsh wlan show profiles 
will list all saved networks. You can then 
delete them with the netsh wlan delete 
profile name=”PROFILE” command, 
but replacing PROFILE with the name of 
the network.

53 Sync settings  
with OneDrive

Open the Charms Bar and head to 
‘Settings > Change PC Settings > 
OneDrive > Sync Settings’. You’ll then be 
shown a list of items you can sync with 
the service if you wish. To sync settings, 
toggle the ‘Sync your settings on this PC’ 
item to ‘On’.

54 Prevent apps  
from connecting  

to the internet
To shield apps from the internet, head 
to ‘Control Panel > Windows Firewall 
> Allow an app or feature through 
Windows Firewall’. Then click on the 
‘Change Settings’ button and uncheck 
the boxes next to the app when 
connected to Public or Private networks.

55 Clear Windows  
Store’s cache

If Windows Store isn’t updating apps or  
is throwing up other errors, it’s a good 
idea to clear its cache and then reset  
the app to its default state. Type wsreset 

on the Homescreen and right-click on 
the WSReset.exe tool and choose ‘Run  
As Administrator’. 

57 Prevent Metro apps  
from using your  

webcam and mic
Bring up the Charms bar and head to 
Settings > Change PC Settings > Privacy. 
Then go to the Webcam section and 
turn off the ‘Let apps use my webcam’ 
option. Similarly, go to the Microphone 
section and disable the ‘Let apps use my 
microphone’ option.

58 Back up Windows 
credentials

Head to ‘Control Panel > Credential 

Manager’. Select ‘Windows Credentials’ 
and click on ‘Back up Credentials’. It’ll 
launch a wizard that’ll ask you for the 
location of the backup file and also lets 
you protect the file with a password.

59 Set your geographic 
location with ease 

Some Store apps, such as News and 
Weather, display content based on your 
geographic location. You can set this 
correctly by going to ‘Control Panel > 
Region > Location’. Here you can use the 
pull-down menu in the ‘Home Location’ 
section to select your country. You may 
have to set this manually if you travel to 
different locations often.

60 Check apps 
disk usage
To check how much disk space 
individual apps are taking up, 
bring up the Charms bar and go to 
‘Settings > Change PC settings > 
PC and devices > Disk space’. Then 
click the ‘See my app sizes’ link to 
get a detailed list.

56 Monitor 
your children
Go to ‘Control Panel > User 
Accounts and Family Safety > 
Family Safety’ and click on 
‘Manage Family Safety’. You’ll then 
be taken to a website where you 
need to login using your Microsoft 
account. Once logged in you can 
get detailed reports about 
non-admin users.
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Settings & tweaks
61 Display a Login 

Message
Type secpol on the Start Screen and 
then navigate to ‘Local Policies > Security 
Options’. Next, find the options labelled 
‘Interactive Logon: Message title for 
users attempting to log on’ as well as 
‘Interactive Logon: Message text for users 
attempting to log on’. Right-click on each 
of these, then select ‘Properties’ and type 
in your message.

62 Enable the  
Hibernate option

To add the Hibernate option to the Power 
menu, head to ‘Control Panel > Hardware 
and Sound > Power Options’ and click on 
‘Choose what the Power buttons do’.  
Then click the ‘Change settings that are 
currently unavailable’ link and enable the 
‘Hibernate’ checkbox.

63 Temporarily disable 
notifications

To mute all types of notifications, bring 
up the Charms bar and go to ‘Settings > 
Notifications’. From here you can select a 

preset duration and turn of notifications 
for either one, three or eight hours. 

64 Delete old  
installation files

If you’re running out of disk space, you 
can delete old installation files. Type disk 
cleanup at the Start Screen to launch the 
tool and click on the ‘Clean up system 
files’ button. Then select the ‘Previous 
Windows installations’ option, and run  
a disk cleanup. 

65 Move pointer to  
default button 

To automatically focus the mouse  
pointer on the default dialog box  
buttons, head to ‘Control Panel > Mouse’ 
and switch to the Pointer Options tab.  
Here toggle the ‘Automatically move 
pointer to the default button in a dialog 
box’ under the Snap To section. 

66 Run system 
maintenance 

troubleshooter
To streamline your computer, head 

to ‘Control Panel > Troubleshooting’. 
Here scroll down to the System and 
Security section and click on the ‘Run 
maintenance tasks’ option. The tool will 
detect issues and recommend solutions 
to resolve them.

67 Customise Search
If you don’t want Windows 

Search to index the entire PC, type 
indexing on the Start Screen and then 
launch the ‘Indexing Options’ tool. Now 
click the Modify button to configure the 
items to index.

68 Disable Search indexing
To disable the Search Indexing 

feature altogether, type serv on the Start 
Screen and select the ‘View local services’ 
link from the results. Scroll through the 
list of services and find Windows Search. 
Double-click to it and change ‘Startup 
type:’ to Disabled.

69 Optimise drives
To improve the performance of 

the drives on your PC, type optimize 

70 Customise 
Privacy 
options
Bring up the Charms bar and go to 
‘Settings > Change PC settings > 
Privacy’. Here you’ll get various 
privacy-related settings under the 
General section including the 
ability to stop apps from accessing 
your personal data.
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in the Start Screen and select the 
‘Defragment and optimize your drives’ 
utility from the results. In the tool select a 
drive and press the Optimise button.

71  Disable Visual effects
Launch the Control Panel 

and head to System and ‘Security > 
System > Advanced system settings’ 
and click on the Settings button under 
the Performance section. Then toggle 
the ‘Adjust for best performance’ radio 
button under the ‘Visual Effects’ tab to 
turn them all off.

72  Control shutdown 
behaviour 

Head to ‘Control Panel > System and 
Security > Power Options’. If you want  
your change to apply to all plans click  
on ‘Choose what closing the lid does’  
and use the pull-down menu to change 
the behaviour to either Sleep, Hibernate  
or Shutdown. 

73  Change the  
Computer name

To rename your PC, bring up the Charms 
bar and head to ‘Settings > Change PC 
settings > PC and Devices > PC info’. 
Here click on the ‘Rename PC’ button 
and restart the computer.

74 Mute all sounds when 
someone calls 

To automatically turn off all sounds 
when you receive a Skype call, launch 
the Control Panel and head to Sound. 
Here switch to the Communication tab 
and under the ‘When Windows detects 
communications activity’ section, toggle 
the ‘Mute all other sounds’ radio button.

75 Disable SmartScreen
Privacy conscious users might 

want to disable the SmartScreen feature 
by going to Control Panel > System and 
Security> Action Center. Here click on 
‘Change Windows SmartScreen settings’  
and toggle the ‘Don’t do anything (turn 
off Windows Smartscreen)’ radio button.

76 Enable network 
discovery

To make your computer visible to others, 
go to ‘Control Panel > Network and 
Internet > Network and Sharing Center’ 
and click on ‘Change advance sharing 
settings’. Then go to Private profile 
section and toggle the ‘Turn on network 
discovery’ radio button.

79 Switch to a local 
account

To sign into Windows with a local 
account instead of a Microsoft account, 
bring up the Charms bar and go to  
‘Settings > Change PC settings > 
Accounts’. Under ‘Your account’ select 
‘Disconnect’ and in the next step create, 
and log in to a local account.

80 View recently  
modified settings

If you wish to revert any recent 
modifications to the computer, simply 
bring up the Charms bar and head over 
to ‘Settings > Change PC settings’ and 
then click on the ‘View recently used 
settings’ link to view all the recently 
modified settings.

78 Change 
authentication 
mechanism
Bring up the Charms bar and head to 
‘Settings > Change PC settings > 
Accounts > Sign-in Options’. From 
here you can replace the password 
with a easier to remember four-digit 
PIN or a picture-password.

77 Enable 
Narrator
Bring up the Charms bar and head 
to Settings > Change PC Settings 
> Ease of Access > Narrator. As 
soon as you toggle the Narrator 
slider to On, Windows will 
helpfully read out the text which 
has the cursor focus.
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81 Close any  
unresponsive apps

Press the [Ctrl]+[Alt]+[Del] hotkeys and 
select ‘Task Manager’, which displays all 
the running apps. Right click on the app 
that has become unresponsive and select 
‘End task’ to kill the app. 

82 Create recovery disc
Plug in a USB drive and type 

recovery on the Start Screen and select 
the ‘Create a recovery drive’ option from 
the results. This will launch a wizard which 
wipes the USB drive and transforms it 
into a recovery drive.

83 Enable the handy 
Administrator account

By default, the built-in Administrator 
account is hidden. To enable it, launch 
the Command Prompt as Administrator 
and type net user administrator /
active:yes. Now logout to see the newly 
added Administrator account on the 
login screen.

84 Speed up the 
Taskbar preview

Launch regedit and go to ‘HKEY_
CURRENT_USER > Control Panel 
> Mouse’. Here right-click on the 

MouseHoverTime key, choose ‘Modify’ 
and replace the number in ‘the ‘Value 
Data’ box with 1. The previews will now 
show up in 1 millisecond. 

85 Disable low  
disk check

Run regedit and go to ‘HKEY_CURRENT_
USER > Software > Microsoft > Windows 
> CurrentVersion > Policies’. Right-click 
in right pane and create a new key called 

‘Explorer’. Inside it create a DWORD (32-
bit) Value named ‘NoDiskSpaceCheck’ 
with a value of 1.

88 Optimise SSD
If you’re running Windows on 

a Solid State Drive, make sure you run 
the Windows Self Assessment Tool. Type 
winsat on the Start screen and launch 
the tool as Administrator. Reboot the 
computer once it’s done.  

89 Decrease the  
shutdown time

Reduce the wait before killing user 
processes down to an impressive  
two seconds. To do this, first launch 
regedit and then navigate to HKEY_
CURRENT_USER\Control Panel\Desktop 
and create a new DWORD (32-bit) key 
named WaitToKillAppTimeout, with a 
value of 2000. 

90 Disable Action  
Center notifications

Type action at the Start Screen and 
select the ‘Action Center’ option from 
the results. Now click on Change Action 
Center settings and simply uncheck the 
types of messages you no longer wish to 
be notified about.

86 Mount ISO 
images
You don’t need any third party 
software to browse the contents 
of an ISO image. Right-click on the 
ISO image and click ‘Mount’. The 
ISO images are mounted as virtual 
discs and you can access them 
from the File Explorer.

87 Setup Kiosk 
mode
To restrict a user to just one app, 
bring up the Charms bar and head 
to ‘Settings > PC Settings > 
Accounts > Other accounts’ and 
click on the ‘Set an account for 
assigned access’. Then simply 
select the account and the 
application from the list.

Advanced tricks 
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91 Share mobile 
connection

Bring up the Charms bar and go 
to ‘Settings > Change PC Settings 
> Network’. Then select a Mobile 
broadband connection you want to share 
and toggle the ‘Share this connection’ 
option to On. Click on the Edit button to 
change authentication information.

92 Create a  
system image

Type file on the Start Screen and select 
the ‘File History’ tool from the results. 
Then click the ‘System Image Backup’ link 
in the lower-left corner to start a wizard, 
which will let you select the destination 
drive for storing the backup image.

93 Customise the Power 
User menu

To reorganise and or remove entries go 
to C:\Users\<username>\AppData\Local\
Microsoft\Windows\WinX. Here you’ll 
notice three folders that house entries 
for the Power User menu. You can move 
them around or remove them as per  
your requirements.

94 Replace Command 
Prompt with PowerShell

Type navigation on the Start Screen  
and select ‘Navigation properties’ from  
the results. Here, toggle the checkbox 
labelled ‘Replace Command Prompt  
with Windows PowerShell in the menu 
when I right-click the lower-left corner  
or press Windows key + X’. 

96 Boot into  
Safe Mode 

In the Run dialog box enter msconfig 
to launch the System Configuration tool. 
Here, switch to the Boot tab and toggle 
the ‘Safe boot’ checkbox under the ‘Boot 
options’ section. Upon restart Windows 
will now boot into the Safe mode.

97 Access the  
‘God Mode’ 

The God Mode gives you access to all 
system settings and hidden features 
of Windows 8.1. To access it create a 
folder on your desktop and name it 
GodMode.{ED7BA470-8E54-465E-825C-
99712043E01C} Then you should double 
click on it to reveal a categorised list of  
all the settings.

98 Customise the disk 
space for protection

To customise the disk space for 
protection, first launch the Control Panel 
and head to ‘System and Security > 
System > System protection’. Now click 
on the Configure button, found under 
the ‘Protection Settings’ section, and  
use the slider next to ‘Max Usage’ as per 
your requirements.

99 Enable the  
Guest Account 

Type user on the Start Screen and select 
the ‘User Accounts’ option from the  
results. Now click the ‘Manage another 
account’ link and select the Guest icon. 
Then press the ‘Turn On’ button to 
enable the guest account.

100 Store 
multiple 
copies of files
The Storage spaces feature lets 
you combine multiple disks into 
one virtual disk. Type storage on 
the Start Screen and select the 
‘Manage Storage Spaces’ option. 
Then click the ‘Create a new pool 
and storage space’ link and select 
the drives to be included in the 
storage pool. n

95 Configure 
automatic 
maintenance
Launch the Control Panel and 
head to ‘System and Security > 
Action center’. Then expand the 
Maintenance section and click on 
the ‘Change maintenance settings’ 
link and use the drop-down menu 
to select a convenient time.
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Learn how to…
Capture your 
PC’s screen

“PicPick is the best free screen 
capture tool for Windows – find 
out how to make use of it”

ot all screen-capture tools 
are equal. While most will 
capture all or part of your 

screen, there’s always some 
annoyance – a key feature is missing, 
it doesn’t work the way it should, or 
you have to jump through hoops to 
get the shot you want. PicPick 
changes all of that. It’s the most 
comprehensive free screen capture 
tool we’ve seen, offering no less than 
seven different ways to capture all or 
a select portion of your desktop. It 
even ships with a built-in image 
editor that boasts an intuitive ribbon 
interface and all the key tools you 
need to tweak your grabs before 
saving or printing them, sending 
them to another program (like Word) 
or even sharing them online in a 
variety of different ways. Everything 
is designed to work quickly, easily 
and within a single program – read 
on to find out how it works.

1 First steps
You’ll find the Home Edition of PicPick, which is free for 

non-commercial use, on the cover disc. The installation wizard is 
straightforward – just follow it through, then leave ‘Launch PicPick 
now’ ticked before clicking Finish. The main PicPick window will 
appear, revealing all available tools including all seven capture 
modes. This is just one way you can access these tools.

2 Screen capture
The main PicPick window is a little clunky for screen capture, 

so close it. Instead, right-click the program’s new pinned Taskbar 
icon and choose Screen Capture to reveal a floating widget. This 
sits on top of the other windows, giving you easy access to any 
capture mode. Click its ‘Settings’ button and choose Widget to 
make it smaller, more transparent or lock it into position.

Step-by-step Capture and edit screenshots

Your guide Nick Peers says…

CaPture ChoiCeS
As its name implies, 
this option simply 
captures your entire 
desktop – excluding 
the PicPick widget  
if it’s present. 

CaPture region
Select this to click and draw 
a rectangle around the 
exact region you wish to 
capture – a magnifier makes 
precise selections easier. 

N
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKiLL LeVeL

time taKen

SuitabLe for

20 minutes

26  |    |  June 2015



3 More ways to capture
Alternatively, if you prefer, you can access all of these tools 

by right-clicking the program’s Taskbar Notification area icon. You 
can also capture screens using a variety of hotkeys based around 
the [Print Screen] key on your keyboard – for example, [Alt]+[Print 
Screen] captures the currently active window. Review – and edit 
– these keyboard shortcuts via ‘Program Options > Hot keys’.

4 Set capture output
By default any screen captures are sent to PicPick’s image 

editor for editing and annotating. You can choose different 
outputs via the ‘Output Type’ button or ‘Screen Capture > Output 
type’ menu – send to clipboard or printer, save directly as a file 
(use the Default Image Format menu to pick your file type), share 
online via various services or send to another program.

Jargon buster!
 Screen capture

The process of taking 
a picture – known as 
a screenshot – of all 
or part of your 
computer’s desktop.

 region
An area of the 
desktop that’s 
selected for capture 
by clicking and 
dragging the mouse 
over the desired part 
of the screen.

 Widget
A small – often 
floating – application 
that offers a subset 
of features found in 
its parent program. 
In PicPick’s case, its 
widget provides easy 
access to its screen 
capture tools.

aCtiVe WindoW
This option 
automatically grabs the 
window that’s currently 
in focus, so select  
your chosen window 
before clicking. 

WindoW ControL
Capture all or part of  
a specific window by 
moving your mouse over 
it. Use the red rectangle 
as a guide before 
clicking to capture. 

fixed region
Click, select the width 
and height of your 
selection box, then 
position it before 
clicking; press [Esc] to 
change the dimensions. 

get freehand
Click to draw a 
shape around the 
area to capture –  
this is copied into  
a box with white 
background. 

Nick’s best tiP!
send your capture to  
your favourite image  
editor under 'Program 
Options > Auto save'.

Explore 
Capture your PC’s screen
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9 Tweak program settings
Switch to the File tab and choose Program Options to 

fine-tune PicPick. Visit the Capture tab for some useful options: 
choose ‘Use Advanced Window Control Capture’ for precise 
window selection, or use the Auto Scroll scrolling delay to try and 
improve the performance of the Scrolling Window tool. You can 
also include the cursor image with a screen snap.

7 Edit in PicPick
Use the white square drag handles that surround the image 

to crop, by clicking and dragging them to their desired position. 
Click the Image button on the Home tab to rotate, resize and 
access various lighting controls and effects – you could, for 
example, use the Select tool to select a portion of the image and 
then choose ‘Image > Effects > Pixelate’ to hide it from view.

5  Capture options
The annotation reveals most of the capture options 

available. The only option not covered is Scrolling Window, which 
works in a similar way to Capture Window Control. When you click 
to select a window with a scroll bar it should automatically scroll 
down that window and capture the document or web page. It’s a 
little flaky, however, and won’t work with every program.

10 And there’s more
You’ve mastered PicPick’s screen capture and editing tools, 

now try its add-ons. WhiteBoard allows you to turn your desktop 
into a presentation, annotating whatever parts you like. Measure 
the size and angle of desktop elements using the Pixel Ruler and 
Protractor tools, or pick a colour using the Picker and Palette. 
Don't forget the Crosshair and Magnifier tools too. ■

8  Mark up image
Use the Draw tools to access brush, eraser and marker tools 

for labelling parts of your image. Stamps allow you to place 
symbols – including mouse cursors – on the image, while Shapes 
is where you should go to add text boxes, highlight areas or even 
magnify part of the image to show off a specific detail. Once 
complete, save your image or use the Share tab to place it online.

6 Post-capture actions
Once you’ve captured your screen, what then? If you choose 

Image File, you’ll be prompted to choose a format (GIF, BMP, PNG 
or JPG) and filename. Select one of the online sharing options and 
you’ll be prompted to log into the relevant account the first time 
you access it. Choose ‘PicPick Editor’ and the grab will appear in 
PicPick’s editor, ready for editing or marking up.
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Learn how to…
Give photos  
a vintage look

"Vintager applies ageing effects  
to your photos to give them a 
look from a bygone era"

ostalgia really isn’t what it 
used to be, particularly 
where photos are 

concerned. Dig out old photos and 
the signs of ageing all add extra 
charm and ambience to the scenes 
they portray. Modern digital photos 
aren’t subject to the ravages of time, 
but thanks to a wonderful free tool 
called Vintager you can inject some 
nostalgia into your recent snaps and 
see how they might have aged had 
they been shot on film.

It’s simple to use: Vintager gives 
you a choice of 17 filters to try. Many 
apply different coloured filters to 
inject some age and washed-out 
ambience, such as Blossom, Coconut 
or Mint. Others go further: Candela 
adds a layer of artificial scratches, 
while Billie ages the photo by 
darkening it. You can then fine-tune 
these settings to get the perfect shot 
– read on to find out how.

1 Select photos to age
Grab Vintager from your free disc, or download and install it 

from www.exeone.com/vintager. Once installed, leave ‘Launch 
Vintager’ ticked and click ‘Finish’. When the main window opens, 
click the folder button next to Image to pick the photo or photos 
you want to edit. If editing multiple photos, hold [Ctrl] as you click 
each one to select it. Click ‘Open’ when you’re done.

2 Crop, rotate, resize
The first of your selected photos will appear in the preview 

window. First, use the ‘Crop’ tab to select part of the photo using 
your mouse if you want to focus in on a specific part of the image. 
Use the ‘Rotate’ tab to rotate or flip the image, and finally the 
‘Resize’ tab to shrink the size of the finished photo – click the 
anchor button before you begin to preserve its aspect ratio.

Step-by-step How to use Vintager to age your photos

Your guide Nick Peers  says…
Select photoS
Click this folder 
button to discard 
the currently loaded 
images and choose 
a new photo – or set 
of photos – to edit. 

preview window
Use this window to 
both crop into your 
image and preview 
the effects and 
image edits as you 
select them. 

N
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKill level

time tAKen

SuitAble for

10 minutes
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3 Apply effect
Now click one of the five visible preset buttons beneath the 

editing controls to apply an ageing effect to the photo – more 
effects are hidden away, so use the arrow to the right of the preset 
to navigate between them all. Once you’ve found an effect you 
like, use the Colour adjustment tab’s ‘Brightness’ and ‘Contrast’ 
sliders to fine-tune the photo’s lighting until you’re happy with it.

4 Frame and apply
Switch back to the first tab: use the ‘Depth of Field’ menu to 

lighten or darken the edges of your picture, and the ‘Frame’ menu 
if you want to pick your own frame rather than go with the ‘Use 
predefined frames’ option. Once done, click ‘Apply’ – after 
confirmation, copies of the photos will be saved to the same 
folder as the originals unless you’ve ticked ‘Overwrite old files’. ■

Jargon buster!
 Aspect ratio

This is the 
proportional 
relationship between 
an image’s height 
and width. When 
one is resized, the 
other must also be 
resized 
proportionally so  
the image doesn’t 
look squashed or 
stretched.

 Depth of field
The distance 
between the nearest 
and furthest objects 
in a photo that both 
appear suitably 
sharp. Anything 
outside this area 
appears blurred.

 frame
A virtual 
representation of a 
physical photo frame 
that is used to add 
more ambience to 
the photo.

editinG controlS
Options for editing 
your photo are hidden 
behind five tabs: 
Effects, Crop, Rotate, 
Colour Adjustment 
and Resize. 

tAb controlS
This area displays 
different options  
(or instructions 
when the Crop  
tab is selected) 
depending on which 
tab you’ve selected. 

preSet effectS
17 different ageing 
and colouring 
effects are available 
in Vintager – click 
one to apply it to the 
current photo. 

uSe predefined frAmeS
Each preset comes with its 
own recommended frame – 
tick this box to use this instead 
of selecting your own. 

Nick’s best tiP!
tick the ‘Overwrite old files’ 
box with care – if you 
subsequently click Apply, your 
original photos are overwritten .

Explore 
Give photos a vintage look
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Learn how to…
Stay secure 
with Heimdal

"Keep vulnerable software up to 
date automatically – and keep 
malware at bay!"

here are stacks of antivirus, 
anti-malware and other 
security products on the 

market, and it’s important to have 
one you trust installed and working 
at all times. Heimdal is a little 
different, though. It’s a small, 
lightweight program that’s designed 
to work together with your existing 
antivirus program, and continually 
monitors any third-party software 
installed on your PC that might be 
vulnerable to hacks.

 Upgrade to the paid-for Pro 
version and Heimdal can do even 
more. It analyses and blocks 
malicious links to keep you safe from 
phishing attempts, scans for and 
deletes malware, and checks all 
internet traffic to ensure that sensitive 
data, such as passwords and credit 
card details aren’t being sent to 
known hacking servers.

 Let’s see how both the free and 
Pro versions of Heimdal work…

1 Getting the software
Heimdal Free is a tiny program, which you can find on this 

issue’s disc or at https://heimdalsecurity.com. From the website, 
just click the ‘Get It Now’ link, then download the file and run it. 
During setup, make you choose the option ‘I would like to use the 
free or currently registered version of Heimdal’ to install the free 
version. We’ll also look at a way to try the Pro version.

2 First run
When Heimdal Free first starts it’ll do a scan of your PC to 

look for known vulnerable programs – particularly plug-ins such 
as Adobe Flash, which are constantly being updated. By default it 
then automatically downloads updates for any that need it; click 
the Software tab to see what’s been done. There isn’t much else 
you can do with the Free version, so let’s go Pro…

Step-by-step Using Heimdal

Your guide Ed Ricketts says…

Turn iT off and on again
Modules enables you to turn  
on and off specific parts of 
Heimdal individually, such as 
malware detection. 

Tweak iT
In Advanced, change parameters 
such as how often Heimdal scans 
your PC and whether to update 
software automatically. 

keeping TabS
Statistics shows you everything 
that Heimdal has done up until 
now, including updates applied 
and so on. 

STop THe roT
The Malware tab is pretty simple 
– most of the time (hopefully!) it 
should be empty, indicating no 
malware has been discovered. 

keep iT currenT
The Software tab shows you 
which plug-ins are being 
monitored on your PC and 
whether they’re up to date. 

overview
Gives you an at-a-glance look at 
the state of your PC’s health 
according to Heimdal, with a 
percentage score for safety. 

T
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SkiLL LeveL

Time Taken

SuiTabLe for

15 mins
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3 Get a Pro trial
Although the Heimdal Security website doesn’t shout about 

it, there’s a way to get a free month’s trial of Heimdal Pro. Go to 
the website and click the ‘Buy Heimdal’ link. Change Country to 
‘United Kingdom’ and in the Voucher field, enter heimdaldemo01. 
Click ‘Apply’ and the price changes to ‘EUR 0.00 for 1 month’. Now 
enter your email and click ‘Continue to download’.

4 Activate!
The next screen displays your activation code for the free 

month’s trial – copy and paste this and keep it somewhere safe! 
You’ll also see the date your trial expires. There’s no need to 
download the software again – your activation key works with the 
free version you’ve installed. Just copy and paste your key in the 
Go PRO tab of the software to activate it.

Jargon buster!
 Secure dnS

DNS (Domain Name 
System) is the 
internet’s method of 
determining where 
data should go. 
Heimdal checks DNS 
requests so your data 
isn’t sent to known 
hacking locations.

 malware
Any hostile or 
intrusive software 
such as viruses, 
trojan horses, 
spyware and so on.

 phishing
Any attempt to get 
personal information 
such as usernames 
or passwords by 
posing as a 
legitimate website.

Ed's bEst tip!
Heimdal doesn't include an 
antivirus tool – so keep your 
existing antivirus installed 
when using it.

Explore 
Stay secure with Heimdal
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9 Alert, alert
Occasionally Heimdal won’t be available to automatically 

update certain programs itself, particularly more complicated 
ones such as Flash browser players, which often need to be 
installed manually. In that case, you’ll see the red ‘!’ icon in the 
Software tab, indicating a failed update. Try to update it yourself 
as soon by going to the relevant site such as adobe.com.

7 Customise at will
In the ‘Modules’ tab, turn on or off parts of Heimdal. The 

‘Software’ section is similar to the options in ‘Advanced’. Having 
‘Secure DNS’ enabled means Heimdal can check ingoing and 
outgoing traffic to ensure data isn’t being sent to known 
phishing sites. ‘Malware Detection’ lets it look for suspicious 
behaviour on your PC, as well as unusual network activity.

5  Fine-tuning
 You can go to the Advanced tab to customise Heimdal’s 

operation. If didn’t want automatic download updates but still 
want to know about any that are available, untick the box under 
‘Update’. You can change the frequency of scans for PC checks and 
software updates – the default 60 minutes is a bit excessive. 
‘Proxy’ and ‘Send Trace’ are advanced options for special cases.

10 Want more?
Finally, the License section (only shown in the Pro version) 

displays your activation key, the date your licence expires, and 
when the software last verified the licence over the internet. If 
you find Heimdal is useful, remember you can always buy the full 
version after your month’s trial expires – it costs €34 for a year’s 
subscription. Just go to the main Heimdal website to purchase. ■

8  What’s going on?
The Statistics tab shows you everything that Heimdal has 

done to date, including vulnerabilities detected, any software 
updates it has applied, and when it last updated its own data or 
signatures. Click the ‘Details’ button to see a full list of all updates 
Heimdal has applied to itself. Here, it detected a vulnerable Flash 
plug-in twice, because we’ve turned off automatic updates.

6 Badness begone
In the Malware tab, there should be very little to see – at 

least, that’s the ideal! If Heimdal does detect any known malware 
or ‘info stealers’ (programs that try to steal your personal details 
such as passwords) on your PC, it will attempt to eradicate them 
and pop up a message to let you know. You can check out exactly 
what it’s done in this section.
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Learn how to…
Solve common 
OneDrive problems

“Annoying errors from Microsoft’s cloud backup 
tool can be repaired with a few clicks using  
a simple app from the company’s website”

neDrive gives you 15 free 
gigabytes of cloud storage 
and file-syncing apps that 

work on almost every platform. It’s a 
good deal for Windows users and an 
integral part of the latest version of 
the operating system, but it’s a 
complex bit of network programming 
and things can go wrong. 

If OneDrive starts misbehaving, 
Microsoft provides a tool to repair the 
common problems that occur. The 
OneDrive Troubleshooter can be 
downloaded from the Microsoft 
website and will analyse your 
OneDrive installation for the most 
frequent problems. 

As OneDrive is the default saving 
location for documents under 
Windows 8.1, and also backs up your 
photos, losing access to the system 
can prevent the syncing of your work 
to other devices, as well as potentially 
ruining your backup plans. Let’s see 
how to fix it.

1 Get the app
Getting the app onto your computer is easy, but you’ll need 

to be online. If your OneDrive woes are a symptom of a network 
outage, this needs to be fixed before you can continue. If your 
connection is working, go to http://windows.microsoft.com/
en-gb/windows-8/onedrive-troubleshooter to read about the 
app, or http://go.microsoft.com/?linkid=9835055 for a download.

2 No need to install
Once the file has downloaded to your PC, there’s no 

installation routine. Run the file from your browser’s download 
queue (click the filename at the bottom of the screen in Chrome, 
click ‘Save’ then ‘Open’ at the bottom of the screen in Internet 
Explorer, and click ‘Save File’ followed by the filename in Firefox). 
Or find the file in the folder it’s been saved to and double-click it.

Your guide Ian Evenden says…

O

Ian's best tip
Leaving the troubleshooting 
app switched on so it fixes 
problems itself makes it a fast 
and smooth process.

Step-by-step Troubleshoot OneDrive

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE fOr

10 minutes
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7 Make repairs
The troubleshooter is a well-behaved program, and as we 

turned off automatic fixing of problems in step 3, it pops up the 
segment of the Control Panel for us to make the repair ourselves. 
On our PC, the problem was User Account Control had been 
turned off, something OneDrive can’t abide and a security risk for 
the PC. We return it to its default setting, and all is well again.

8 Read more
Once everything is fixed, you’re given two last options. You 

can explore further options, which closes the troubleshooter and 
opens Windows Help so you can read more about the settings 
that were causing problems. Or you can choose to close the 
troubleshooter. The downloaded file might be worth keeping if 
you’re a regular OneDrive user, as you might need it again. ■

5 Reset?
When the detection process is over, you’ll be offered the 

choice to reset OneDrive. This will fix many problems, but also 
means the app will re-synchronise your files, so if you have stored 
data in the cloud and a slow internet connection, this option can 
take a while to complete. The good news is you can still work in 
other apps as it does it, but nothing you do will be backed up.

3 Advanced
When the app opens, you’ll be presented with a window 

with little more on it than a Next button. It’s worth clicking the 
‘Advanced’ link, though, as this enables you to turn off automatic 
fixing of problems – if there’s something you don’t want the app 
to ‘fix’, such as a setting you chose for another reason, this is your 
chance to regain control over the process.

6 What's wrong?
If you opt not to reset, and unticked automatic fixing of 

problems in the advanced settings in Step 3, you’ll be presented 
with a list of what’s wrong. If you’re on a computer administered 
by someone else, you may not be able to fix some of these. 
Others, such as the User Access Control, can be fixed manually 
from the Control Panel. Or you could let the app do it for you.

4 Scan for problems
You might be asked for an Admin password. Click ‘Next’, and 

the troubleshooting app will begin detecting problems. The 
detection process shouldn’t take long, but if your computer has 
become disconnected from the internet, this is the stage at which 
it will fail. If it takes more than a few minutes, it suggests your 
computer is having trouble connecting to Microsoft’s servers.

Explore 
Fix OneDrive
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Learn how to…
Explore the cosmos with 
WorldWide Telescope

“Go star gazing in your own private observatory  
and take a tour of galaxies far, far away”

orldWide Telescope is an 
incredible program that puts 
the universe at your 

fingertips. It was created using 
images and information gathered by 
telescopes, probes and satellites, 
which are combined to create an 
interactive view of the sky that you 
can explore from your desktop.

Astronomers use WorldWide 
Telescope to see the universe in many 
different wavelengths (including 
visible light, infrared and gamma 
radiation), and there’s access to much 
more data via the Astrophysics Data 
System. Right-clicking an object gives 
you more information, such as recent 
papers and Wikipedia entries. 

Despite its complexity, it’s easy to 
navigate. Simply click and drag to pan 
around the sky, use your mouse 
wheel to zoom into an area that looks 
interesting, and right-click something 
that catches your eye. Let’s turn our 
eyes to the starry skies.

1 Get started with the web client
WorldWide Telescope is available as an HTML5 web app and 

a downloadable Windows app. We’ll start with the web version, so 
visit worldwidetelescope.org, scroll down and click ‘Explore WWT 
on the web’. A message appears asking if you want to share your 
location. This is optional, but the information will let you explore 
the sky as you’d see it from outside your own front door.

2 Begin exploring
Read the notes on how to navigate, then click ‘Close’. You’ll 

see an image of the sky with constellations highlighted – click and 
drag to pan around. The list of celestial objects at the bottom of 
the screen changes as you move. Select one to explore in more 
detail. Here I chose Mercury. Click and drag to spin the planet, and 
use your mouse wheel to zoom. The detail is incredible!

Your guide Cat Ellis says…

W

Step-by-step Embark on an interstellar voyage

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

1 hour
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Explore the cosmos with 
WorldWide Telescope

7 Install the Windows app
You can do even more with the downloadable Windows 

application. Return to the WorldWide Telescope homepage, scroll 
down and click ‘Download WorldWide Telescope’. Save the file 
when prompted. Click ‘Next’, accept the licence agreement and 
click ‘Next’ again. Deselect the Microsoft Excel add-on option and 
click ‘Next’ three more times. Click on the desktop icon to open it.

8 No place like home
While you’re using WorldWide Telescope, take a moment to 

visit Earth. You can choose from several views (the Earth at Night 
options are particularly impressive) from different years. You can 
zoom right in to find your house, then move all the way out and 
begin exploring different galaxies again. It’s an amazing tool that 
makes you feel very powerful, but also very, very small. ■

5 Cosmic dust
You can explore the sky using surveys listed in the top 

menu. Zoom out again and click ‘SFD dust map’. Cosmic dust used 
to be an annoyance to astronomers because it obscured the 
objects they were trying to see, but with infrared astronomy it can 
give us lots of information about the formation and lifecycles of 
stars and planets. Try to find a nebula made by a dying star.

3 Pick a star
Let’s take a look at a constellation. Click ‘Constellations’ in 

the top left, then pick one from the menu. Here I’ve chosen Ursa 
Major. Make sure ‘Sky’ is selected under ‘Look at’, then right-click 
one of the stars to learn more about it. Click ‘View object’ and the 
display will zoom right in to show you the star up close. You can 
also see research papers on the star, look it up online and more.

6 Take a tour
Thousands of astronomers have collaborated to make 

WorldWide Telescope an extraordinary tool, and several have put 
together virtual tours of celestial objects and events. Select 
‘Guided tours’ from the top menu, then choose a tour and click 
‘Play’.  You can pause the tour, or right-click anything that looks 
interesting to take a closer look and learn more about it.

4 Go deeper
Use your mouse wheel to zoom out again. Now explore on 

your own. Pan around and find a patch of sky to explore and 
zoom in. Right-click when you see something interesting and 
zoom in for a closer look. Here I’ve found a spherical collection of 
stars called NCGC 6752. It’s visible from Earth, so I could use the 
right ascension and declination to find it with a telescope.

Explore 
Discover the cosmos
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Learn how to…
Integrate Gmail into 
Windows 8.1’s Mail app

View your emails and calendar notifications in 
Windows, without touching your web browser

nfortunately, there’s no 
Google app in Windows, 
and it doesn’t look like one 

will ever see the light of day, so 
unless you normally access all your 
Google services – Mail, Calendar and 
more – within a web browser, you 
can’t view your emails or check 
what’s happening in your diary in 
Windows without loading up the 
web and logging in each time. That is 
unless you know the secret way 
to add them… And, we’re going to 
show you how, so you can view 
Gmail from within the Windows Mail 
app (or Outlook.com). We will also 
show you how to view your crucial 
calendars from Google in your 
Outlook.com calendar. 

The real advantage of doing this is 
that you can view all your emails and 
calendar entries in one place, within 
Outlook, whether they’re from Gmail 
or Outlook.

1 Find Mail app
First, open the Mail app from the Modern UI interface (the 

tiled screen), or you can just search for it by using the 
Windows+[Q] shortcut, typing Mail and hitting ‘Enter’ when it 
appears in the menu. Once you’re inside the app, point your 
mouse cursor in the top-right corner of the screen to open the 
charms bar and click on the Settings option that appears.

2 Choose account
On the new side bar that appears, click on Accounts. This is 

where you’ll normally see all the accounts connected to the Mail 
app, but there might not be any here. To connect a new one, click 
‘Add an account’ and then select the account type you’d like to 
add; in this case it’s the Google one that we want to connect, but 
if you’d like to add other accounts just follow the same procedure.

Your guide Nick Odantzis says…

U

Nick’s best tip
if you want to switch between 
active accounts, click the one 
you want to use in the 
bottom left of the Mail app.

Step-by-step Get access to Gmail services within Windows

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

30 minutes
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7 Export your calendars
You can also access your Gmail calendars from within 

Windows – sign into your Gmail account, go to your Calendar (or 
head to www.google.com/calendar), click the arrow next to My 
calendars and choose ‘Settings’. Then click ‘Export calendars’ to 
save a file to your PC containing an ICS file for each of your 
calendars. Unzip the file not forgetting where you put the ICS files.

8 Import calendars to Outlook
Go to Outlook.com, click on Calendar on the main menu. 

Click ‘Import’ then hit the ‘Choose File’ button. Navigate to where 
you saved the ICS files, open one of them and give it a colour, 
name and charm, if you like. Finally, click on Import and you’ll see 
your Gmail calendar within the Outlook.com calendar. You should 
now have all your Gmail activities synced with Windows. ■

5 Outlook.com and Gmail
Although you’ve connected Gmail to Outlook, you’ll still 

need to import your Gmail settings. Go to www.outlook.com and 
log in using the same Microsoft account you use for your PC. Click 
on the settings cog in the top menu, choose ‘Options > Import 
email accounts’ and click on Google. Finally, click Start to import 
Gmail into Outlook.com. Sign into your Gmail account once more.

3 Sign in
In the window that appears, enter your login details for the 

Google account that you normally use – so an email address and 
your password. Then click ‘Sign in’ to give the Maill app access to 
your account information. You’ll need to allow Mail to access 
some of your Google settings, so click ‘Accept’ when prompted. 
Click ‘Yes’ to allow Windows to remember your sign in information.

6 Importing emails
The import process could take some time, depending on 

how many emails you have in your account. Once it’s finished, 
you’ll see that your Gmail emails are merged with your Outlook 
ones, which might not be entirely to your liking. To see your Gmail 
emails on their own, click on your email address under the 
‘Categories’ heading in bottom of the left hand menu.

4 Get Gmail everywhere
Now click on ‘Connect’ to access Gmail in all the other areas 

you would use your Microsoft account, such as on Outlook.com 
– the web version of the Mail app. Sign in and you’ll be taken to 
Mail. You’ll see your Gmail emails, as well as any other folders you 
normally use. Don’t worry if you can’t see another email account 
you have connected, you can switch between them any time.

Explore 
Integrate Gmail into Windows
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Learn how to…
Build an impressive-
looking website

Put a touch of the professional into your first  
website by using WebSite X5 Home 11

uilding your own website is 
the ideal way to place 
yourself front and centre on 

the internet. Whether the site is for 
your small business or just a fun 
project for friends and family, by 
doing it all yourself you can choose 
exactly how you want your site to 
look, with its own feel that will make 
you stand out from everyone else. 

However, if you’ve never built a site 
before, it can seem daunting. We’ve 
secured a free version of WebSite X5 
Home 11 with this issue of Windows 
Help & Advice, and it makes setting 
up your own site really easy. There’s 
no code to deal with, and you don’t 
need to have a flair for design 
either – the building blocks are 
provided for you, so – essentially – all 
you have to do is choose how you 
want your site to look, and then it’s 
up to you to add the content. In the 
end, you’ll have a smart, professional 
website that you’ll be proud of.

1 Install WebSite X5
Download your free Website X5 Home 11 from http://go.

websitex5.com/wintnthm11en. When you get to the Home 
Activation, prompt click ‘Next’ and enter your email address to 
receive your unique key with which to activate WebSite X5. If you 
want access to some handy extras for your website, you can also 
register your details on the next screen.

2 Activate and launch
Go to your email inbox and click on the link you have just 

received, return to the X5 prompt and hit ‘Next’. Now your copy 
will be activated for use. On the final screen hit ‘Start’ to begin 
making your website. WebSite X5 will open in its own window, 
and on the Home screen you’ll see information, such as settings, 
tutorials and questions posted by WebSite X5 users.

Your guide Nicholas Odantzis says…

B

Nick’s best tip
With preview Mode you can 
check how your site looks at 
any time by clicking the 
‘preview’ button at the top.

Step-by-step Build your own website

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITABLE for

60 minutes

Upgrade  
to WebSite X5 
evolUtion 11 
and receive  

50% off!
go to WWW.WebSiteX5.com/Store  

and enter code Wntntev11
See page 61
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7 More templates
The default style of template uses the Health category. You 

can change it by using the drop-down menu above the templates 
– choose from a variety of themes, including sport, business and 
more. You can even change the menu from horizontal to vertical 
in the menu next to the themes menu and the preview will 
update. Click ‘OK’ after you’ve made changes, then click ‘Next’.

8 Change website text
You can skip this step and leave things as they are, or change 

the way the text looks and works when visitors interact with it. 
Click on ‘Text style’ to modify things such as page text and 
mouseover links – select the one you want to edit from the ‘Page 
Item’ drop-down menu and select it. Click on ‘Template Style’ again 
– you can also edit the way the main menu and drop-down work.

5 Name your site
Now give your website a unique URL. For maximum search 

results, be sensible and spell out what your website offers. For 
example, for vintage hats, try www.vintage-hats.com, as long as 
it’s not been taken. Before you go any further, click ‘Save’ button 
to ensure you don’t lose everything you’ve added so far. Your 
project will be saved to the default projects folder. Click ‘Next’.

3 Start creating
Before you get to the extras on the home screen of X5, go 

right ahead and start creating your site by clicking the Start 
button in the top-right of the window. You’ll be taken to the 
Project Selection area, so first give your site a name underneath 
where it says ‘Create a new Project’. Don’t worry if you can’t think 
of anything inventive just yet, you can always change it later.

6 Choose a look
In the Template selection area you can decide how you 

want your website to look. Use the Default Template, which allows 
you to choose from the ones provided by WebSite X5. Click on 
‘Default Template’ and you’ll see a bunch of choices – click on one 
to see a preview and click ‘OK’ to use it. If you’ve upgraded your 
version you can even create a new template from scratch.

4 Maximise search results
Click the ‘Next’ button in the top-right corner to go to the 

‘General Settings’ area. Then enter information about your 
website to make it searchable. Give your site a name to make it 
easier for people to find it on search engines. In the WebSite 
Description, give as much info about your site as possible – the 
keywords will make your site appear higher in search rankings.

Explore 
Build an impressive-looking website
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13 Add content
Your website is split into several frames, and within each of 

these you can add a specific type of content, such as text or 
images. Drag the content button into the frame. If you want to 
change the way content appears, drag the edges of the box. You 
can also add more rows or columns using the editing tools above. 
To edit each content area, or add text or images, double click it.

11 Add a footer
Click the ‘Footer’ tab in the Template Customisation area to 

edit the footer. The footer could be as simple as an email address, 
or you might want to put an image there. As with the header, hit 
the text box to add plain text, or use the image option to add any 
kind of image to the footer. As this can take a bit of time to get 
right, don’t forget to hit ‘Save’ when you’re done, then click ‘Next’.

9  Add a header
Your website header is the first thing people see when they 

visit your site. And it defines the site’s overall style. In the left 
hand-menu, click ‘Template Customisation’ to edit it. This will look 
different depending on the template you’ve chosen. You can 
enter the name of your website here by clicking the text icon. A 
text box will appear, which you can move around to suit.

14 Publish your site
You’re now ready to publish online. Skip the advanced 

settings section if you’re worried about adding a welcome page or 
advertising message, and go straight to ‘Export’. Click ‘Upload the 
WebSite to Internet’ – you’ll need the FTP address as well as your 
username and password. Get in touch with your hosting company 
for this information. Sites such as 1and1.co.uk offer web hosting. ■

12  Menu changes
In the Map Creation, you can change how your menu works. 

Right-click a heading and select ‘Rename’ to change what the 
menu item says, or use the arrows to change the positions. You 
can add a new page or website level (which can contain more 
pages), or remove any you don’t want. Click ‘Next’ to add content. 
The page you select will be the page you edit on the next screen.

10 Edit the header
You can adjust the text to suit using the options below. First, 

type the name of your site into the Content box. Then change its 
size, colour and font type. You can even add effects, such as a 
drop shadow. Play around with it until you’re happy. If you already 
have a logo that you’d like to use, click the image button and 
choose ‘Image from file’, find the image and open it.
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Learn how to…
Fix hardware 
problems

“Most of us have encountered a hardware 
problem, but Windows will help you identify 
and correct it quickly and easily”

Anyone can do it 
Straightforward
Tricky in parts

minutes

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

At a glance…

30

SKILL LEVEL

TImE TAKEn

SuITAbLE For

ne of the most amazing 
things about PCs is that they 
come in all shapes and sizes, 

from slender Windows 8 tablets to 
portable and powerful laptops, all 
the way up to hand-built gaming 
PCs packed with the most powerful 
components known to man. 

The huge variety is fantastic, but  
it also means we sometimes come 
across hardware problems. There are 
so many possible combinations of 
parts from dozens of manufacturers, 
sometimes they can have trouble 
talking to one another.

This can be frustrating and it’s not 
always obvious where the problem 
lies. But don’t worry – there are a 
number of tools built into Windows 
that will let you find out what’s gone 
wrong quickly and easily, and help 
you fix or replace any problem parts.

I’ll show you how to use them, and 
suggest some common problems 
and solutions. Let’s get going!

1 Open Device Manager
If your computer has started to act a bit strangely recently, 

the first thing to do is see what might be causing the problem. 
As long as Windows will start correctly, you can check out the 
Device Manager by pressing [Windows]+[R] on your keyboard 
and typing mmc devmgmt.msc. You can also open Device 
Manager through Windows’ Control Panel.

2 View your devices
Device Manager lists all the hardware and components that 

are currently installed. If there are any problems a yellow or red 
icon appears by the device, letting you know something is up. 
Right-click on a device and select ‘Properties’. Under ‘Device status’ 
you’ll see a notification telling you whether the device is working 
properly, and if not, what the problem might be.

Step-by-step Identify and resolve hardware issues

Your guide Matt Hanson says…

ConFIgurE A dEVICE
Click this option to get 
Windows to scan for 
hardware problems 
and attempt to fix 
them automatically.

TroubLEShooT AudIo pLAybACK
If you’re having trouble hearing 
sounds through your speakers or 
headphones, run this troubleshooter 
to find out what the problem is.

O
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3 Automatically update your drivers
Faulty drivers are the source of many hardware problems, 

but you can easily update them from the Device Manager. 
Right-click on a device then select ‘Update driver software’. First, 
try ‘Search automatically for updated driver software’. Windows 
will check your computer, and online, for the best drivers, and 
install them automatically. If that doesn’t work, try the next step.

4 Update your drivers manually
You can also install drivers manually. If your device came 

with a DVD containing drivers, insert that. You should also check 
the manufacturer’s website to see if there is a new driver available 
to download. Once done, go back to the Update Driver Software 
page and select 'Browse my computer for driver software'. Click 
'Browse', then select your DVD drive or your Downloads folder.

Jargon buster!
 Control panel

A part of Windows 
that contains lots of 
useful and powerful 
tools. In Windows XP, 
Vista and 7 you can 
get to it by clicking 
the Start menu, and 
selecting ‘Control 
Panel’. In Windows 8, 
go to the desktop 
and bring up the 
Charms bar, then 
select ‘Settings > 
Control Panel’. You 
can also type control 
panel into the Start 
search bar.

 Troubleshooter
A step-by-step guide 
that takes you 
through the process 
of identifying and 
fixing any problems.

 rAm
This stands for 
random-access 
memory and is an 
essential part of 
modern computers. 
It lets Windows 
access stored 
information quickly, 
and the more RAM 
you have, the more 
data your PC can 
use quickly.

SEArCh box
Use this to find what you’re 
looking for faster. From the 
main Control Panel window, 
type troubleshooting into the 
search box to see this window.

FIx probLEmS wITh  
wIndowS updATE
Although Windows Update deals 
mainly with software, it’s worth 
checking there were no Windows 
Update problems, as they can 
occasionally affect hardware.

Explore 
Fix hardware problems
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9 More serious issues
Sometimes a hardware problem is so severe that Windows 

won’t start. When you turn on your PC, a long beep or a series of 
short beeps can inform you what is wrong. For example, one long 
beep tells you that the graphics card is not powered properly. 
It varies according to the manufacturer, so you may need to 
search the internet, or take it to a store to be fixed.

7 Solve memory problems
If something is wrong with its RAM, your PC can be plagued 

with problems. You can identify and fix these issues by opening 
the Control Panel and typing memory into the search box. Under 
‘Administrative tools’, select ‘Diagnose your computer’s memory 
problems’. You can either restart Windows now and check for 
problems, or have it check next time you start your computer.

5 Open the troubleshooter
Another way to find solutions to hardware problems is 

to use the Hardware and Devices Troubleshooter. Open up the 
Control Panel, then in the search box in the top-right hand corner 
of the window type troubleshooter and press [Enter] on your 
keyboard. Under Troubleshooting click ‘Find and fix problems’, 
then select ‘Configure a device’.

10 Troubleshooting tips
Following these steps you should now be able to fix any 

hardware problems you encounter. Start with the most obvious 
problem, such as a driver error, then work your way through each 
step. You’ll hopefully hit the solution as you go. Unfortunately, 
some serious problems may require the help of a professional to 
either fix or replace the faulty hardware. ■

8 Fix your network adapter
Can’t connect to the internet? Unplug your modem from 

the power supply, wait 20 seconds, then plug it back in. Once 
it has restarted, try connecting again. If that doesn’t help, type 
network in the Start menu (or the Start screen in Windows 8). 
Click ‘Network > Network and Sharing Center > Change adapter 
settings’. Right-click your network connection and click ‘Diagnose’.

6 Follow the steps
With the Hardware and Devices Troubleshooter open, 

click ‘Next’ to begin. Windows will now scan your system and 
attempt to fix any problems it finds. When it does, you’ll see a 
list of changes it has made, and you should be able to continue 
working. You can also select ‘Explore additional options’ or ‘View 
detailed information’ for more clues about what has gone wrong.
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Learn how to…
Rid your PC  
of malware

“If your PC is behaving strangely, 
malware could be to blame.  
It’s time for some detective work”

our internet security suite or 
advanced antivirus program 
is always the first line of 

defence in combating internet-based 
threats. But while a virus or trojan 
will almost certainly be caught, less 
obvious malware can fall through the 
net. We don’t usually recommend 
using a second security suite, but 
HitmanPro is a great tool for getting a 
second opinion on possible malware. 

HitmanPro has a behavioural 
scan tool, which it uses to check your 
computer for potential virus activities 
or suspicious files that have the 
characteristics of malware. For the 
files that are classified as suspicious, 
HitmanPro sends a request to the 
Scan Cloud for confirmation that 
these files are indeed malicious. If the 
file is unknown, HitmanPro uploads it 
to the Scan Cloud, where it is scanned 
using the antivirus programs of five 
different vendors. I’ll guide you 
through all of its main options.

1 Install and set up
HitmanPro is free for a month and can be downloaded from 

surfright.nl/en/hitmanpro. During the installation process you  
can opt to scan your computer on startup. I recommend checking 
this option for extra security. Note that HitmanPro doesn’t actually 
need to be installed – it can be run straight from a USB drive, a CD/
DVD, a local hard drive or a NAS drive.

2 Auto removal
Choose ‘Next’ on the Install screen, then click ‘Next’ again 

when you reach the main interface. You’ll initiate a Quick Scan 
by default, which will look at every folder on your PC for pesky 
malware that might have slipped through your standard security 
suite’s net. If you see ‘Delete failed’ in the list of identified files, you 
need to close the web browser that you currently have open.

Step-by-step Stop malware in its tracks

Your guide Christian Hall says…

PRogRam 
SettingS
This is where you’ll 
find the most 
rudimentary settings 
that affect how 
HitmanPro works. 
Crucially, this is 
where you can get 
HitmanPro to scan 
for any toolbars 
that try to install 
themselves without 
your approval. 

Y

CHristian’s best tip!
You have to activate your 
trial version of Hitmanpro. 
Go to ‘settings > Licence > 
Activate free licence’.

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8.1
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKiLL LeVeL

time taKen

SuitabLe foR

40 minutes
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3 Report status
When the scan has run, the program will automatically 

remove any browser tracking cookies and alert you if it’s found 
any other threats that need your attention. The total number of 
objects scanned and the time of the scan are displayed, and you 
can save the report log by clicking on the option in the bottom 
left corner of the window. Tap ‘Close’ and your scan is complete.

4 Delete unwanted programs
Once your scan is finished, choose ‘Settings’. You’ll be taken 

to the Settings tab by default, with an option called ‘Scan for 
Potential Unwanted Programs (PUPs)’ already selected. Below 
this you’ll see a drop-down menu. Select ‘Delete’ if you want 
HitmanPro to automatically remove add-ons such as browser 
toolbars that were added when you installed other programs.

Jargon buster!
 malware

A catch-all term to 
describe malicious 
software that finds 
its way onto your 
PC. It can mean any 
threat, but here 
we use it to mean 
malicious programs 
other than viruses 
and trojans that are 
primarily found 
through the internet.

 Proxy
An intermediary 
server connecting 
your PC to an end 
destination server via 
the internet. Proxy 
servers are most 
commonly used to 
help a PC get access 
to servers that it 
normally wouldn’t 
be able to access.

 behavioural scan
Using a clever series 
of algorithms, it’s 
possible for some 
software programs 
to identify files and 
apps that pose a 
threat, even if it’s 
not initially obvious 
that they are up to 
something malicious.

SCan oPtionS
This tab will let you schedule 
a malware scan in much the 
same way you’d set up a regular 
antivirus scan using your main 
security suite. 

SCan hiStoRy
Any items that HitmanPro 
has deemed to be harmful 
will be delivered to the 
Quarantine area on this tab. 
There’s also a sub-tab called 
Logs, where you’ll find 
detailed information about 
the program’s scans. 

PRoxy SettingS
Here you can change the 
proxy options that HitmanPro 
will use. By default, the 
program uses Internet 
Explorer’s settings, but if you 
use different options when 
browsing the web, you can 
enter them here manually. 

adVanCed SettingS
If you have a quarantined file you 
can use VirusTotal to check it online. 
Alternatively, you can enable the EWS 
(Early Warning System), but this is for 
experts only and could potentially 
disable a core boot element of your PC. 

Explore 
Rid your PC of malware 
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9 Rescue a ransomed PC
If you ever encounter malware that holds your PC hostage 

by encrypting your data until your pay a fee, you can insert the 
USB stick that contains Kickstart, enter the boot menu of the 
BIOS and select it. You now have a choice of two ways to boot. 
The default option here skips the master boot record, bypassing 
the ransomware so you can start Windows and run HitmanPro.

7 Explore advanced features
Under the Advanced tab you’ll see an option called Disk 

Mode. Leave this set to ‘Direct disk access (recommended)’ to 
allow HitmanPro to scan your PC when you start Windows. In the 
VirusTotal section you can choose to use HitmanPro’s partner 
VirusTotal service to analyse files or URLs. You can sign up for it 
within HitmanPro using the link provided.

5  Scan preferences
On the second tab, you can change how HitmanPro scans 

your PC. You’ll find all the usual options, such as when to perform 
scans and what type of scan to carry out (default or quick), but 
there are also a few unusual options, such as the ability to prevent 
scans when a fullscreen program is in use, or to add a ‘Scan with 
HitmanPro’ option for files and folders in Windows Explorer.

10 Stay safe
If you need to remove a threat from your PC, you’ll have 

to buy the full product, but you can use the VirusTotal tool in 
the meantime. You can schedule scans in HitmanPro by day of 
the week and time, but if you’d rather use the Windows Task 
Scheduler to plan your regular maintenance, simply follow the 
instructions provided at http://bit.ly/Lfj8qe. ■

8  Grab Kickstart
From the main screen, choose the ‘Kickstart’ icon. You will 

be asked to insert a USB stick. Do so, then select it from the 
list (if there’s more than one attached) and click ‘Install Kickstart’. 
You’ll be alerted that the USB stick will need to be formatted 
before the program can be installed. This will delete everything 
on the stick, so make sure it doesn’t contain anything important

6 Quick commands
You can also use HitmanPro via the command line. Click 

‘Start’ and search for command prompt. Now type C:\Program 
Files\HitmanPro\HitmanPro.exe followed by a command (such 
as /scan). One of the most useful commands is /fb (Force Breach 
mode), which terminates non-essential processes. You can find a 
PDF containing the full list of commands at http://bit.ly/LarvDj.
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free media 
players

No frills VlC Media Player has a simple interface that’s easy to master, but includes 
some little extra touches, such as visual effects that move in time with your music

VLC (videolan.org) will handle pretty much any media 
file you can throw at it. Its default interface will be 
familiar if you’ve ever used Windows Media Player, but 
you can give it a different look by downloading free 
‘skins’ from VideoLAN’s website.

Using VLC is easy as pie and it includes some nice 
little extras like colourful patterns that move in time 
with your music, and subtitles for TV shows and films.  
It even supports gestures for quick navigation, and the 
website offers a range of user-created add-ons.

VLC was created by a nonprofit organisation with the 
help of volunteers, so you might like to make a small 
cash donation to support future updates if it becomes 
your main media player.

1 VLC Media 
PLayer

if you’re looking  
for an alternative  
to Windows Media 
Player, here’s our 
roundup of the best 
music and video  
players out there
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MoVie star sMPlayer is a brilliant free music and video player, 
and includes built-in support for high-resolution Youtube content

Modular desigN With goM Media Player, you can decide which 
playlists and menus you want to see, and position them yourself

GOM (gomlab.com) looks fantastic, with only a 
discreet text ad at the bottom and a couple of 
toolbars to avoid during installation. The first time it 
runs, it asks you to choose a playback option (normal, 
high-quality and TV output) to ensure it works well 
with your media setup, which is a thoughtful touch. 

Have a poke around the menus and you’ll find lots 
of interesting bonus features, including the ability 
to cut the vocals out of songs to create your own 
karaoke tracks. In fact, the sheer wealth of options 
could be a little overwhelming for newcomers, but 
it’s well worth taking the time to explore them all.

If you’ve got a stack of DVDs sitting beside 
your PC, take a look at SMPlayer (smplayer.

sourceforge.net). We particularly like its built-in 
YouTube support, which lets you search for and 
stream high-res videos straight to your desktop. You 
can also download subtitles from the Opensubtitles.
org database, which is a feature we’d like to see in all 
players. SMPlayer remembers the settings for your 
files, so if you close a video, you can re-open it and 
pick up where you left off. There are also some nifty 
features for audio playback, including the ability to 
turn your favourite songs into karaoke tracks by 
stripping out the vocals, as in GOM. 

When installing SMPlayer, select ‘Custom’ if you 
don’t want the Amazon browser bar or Outfox.tv. 

KMPlayer (kmplayer.com) stands out thanks 
to its brilliant support forums, where you can 

chat with other users, learn about updates and report 
any bugs. Many languages are catered for, including 
Chinese, Polish and Farsi.

Again, it’s important to take care during the 
installation if you don’t want to add the Ask toolbar 
to your browser or join the Paltalk Network (clicking 
‘Decline’ won’t stop the player installing).

The player is slick and professional-looking, but 
there’s lots of advertising, with extra pop-up ads 
appearing at the bottom periodically. If you can 
overlook these, it’s a feature-packed program that 
can handle a huge variety of media files, and can 
even connect to your social media accounts.

2GOM Media 
PLayer

3 SMPLayer

5KMPLayer

Zoom Player (inmatrix.com) has a stylish 
modular layout that lets you mix and match 
menus to your heart’s content. It’s beautifully 
designed too, with a range of colour schemes.

Zoom works with all versions of Windows, 
and can detect and install missing components 
that could stop your videos playing properly. 
It organises your files into neat categories, and 
will fine-tune the sound and picture to suit 
your hardware. If that sounds a bit complicated, 
there are video tutorials on the developer’s 
YouTube channel to help you find your feet.

4 ZOOM  
PLayer
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JetAudio (jetaudio.com) is a hefty download, so if your internet 
connection is a bit poky, you might want to consider one of 

the more lightweight options such as VLC or MPC Home Cinema. 
JetAudio is also a bit sneaky – although we were careful during the 
installation process, we still ended up with two unwanted programs 
installed on our PC in addition to the media player. They’re easy to 
remove, but it’s hassle we would rather avoid.

Once you’re past that, this is a great little media player that would 
make a fine addition to your desktop. As its name suggests, it’s 
designed chiefly for music rather than video. We like the modular 
design, which lets you choose which controls and playlists you’d like 
to display, and arrange them however you like. You can also rip music 
from your CD collection and convert file formats, which is very handy.

We’re very impressed with foobar2000  
(foobar2000.org) – a modest player that’s 

frugal with your PC’s resources, making it great for older PCs.  
It doesn’t look especially glamorous, but everything is arranged 
in a neat and sensible way. Your library is arranged down the 
left-hand side, much as it is in Windows Media Player, and your 
current playlist is in the centre. A little equaliser at the bottom is 
the only nod towards embellishment.

When downloading foobar2000, ignore any large green 
buttons on the website labelled ‘Download now’ – these are 
cunningly disguised ads. Instead, select the ‘Download’ tab 
from the menu at the top of the homepage, then grab the latest 
stable version (the player is updated regularly).

The only drawback is that foobar2000 doesn’t support video, 
so you’ll have to try one of the other players here if you’re more 
of a film buff than an audiophile. ■

8JetaudiO

10fOObar2000

RealPlayer (real.com) has been around for a 
long time – even longer than Winamp. It’s 

available for just about every operating system there is 
(both desktop and mobile), and is packed with features. 
You can listen to internet radio, sync music with your 
phone, download videos from the web and share them 
via social media, and lots more.

The player scans your PC for media, which eliminates 
the need to load everything manually. Unfortunately it 
also attempts to install browser toolbars and a Norton 
trial, so read the text carefully before you click anything.

RealPlayer looks very smart. Some options, such 
as ‘Clean up media library’, are actually links to the 
paid-for version of the player, but if you’re enjoying the 
free edition it might be worth considering the upgrade.

Sometimes you don’t want to mess around with 
fancy interfaces – you just want to relax with your 
favourite music or grab some popcorn and enjoy a 
film. That’s where Media Player Classic Home Cinema 
(mpc-hc.org) comes in. The player downloads and 
installs in moments, making it ideal if your internet 
connection is a bit on the slow side. 

Its interface is pared down to the bare minimum, 
but it can still fulfil all your media-playing needs. Best 
of all, its system requirements are very modest. It will 
even work on a 10-year-old PC running Windows XP.

7reaLPLayer

9 MPC hOMe 
CineMa

MusiC to Your ears the team behind foobar2000 have focused their energies 
on doing just one thing very well, and the result is a fantastic free music player

old faVourite 
With 18 years of 

development 
under its belt, 
realPlayer is a 

pleasure to use 

When you fire up EDM (easy-data.no), you could be 
forgiven for thinking you’d travelled back to the 
mid-1990s. It’s a competent player, but it’s no looker.  
To jazz it up, you can take your pick from a range of 
wallpapers (though the default stars are the most 
tasteful), or try a full-screen psychedelic effect. 

Another quirk is that the ‘Get artist information’ link 
takes you to the band’s Wikipedia page rather than 
scouring the web for track titles, as you might expect.

It’s an odd one, no question. But if you have a taste 
for retro software, it might be just the ticket.

6 eaSy-data 
MediaCenter
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xpert’ is a relative term 
– by which I mean it’s a 
term that our relatives 
use. “Ask Luis, he’s the 
computer expert,” my 

mother-in-law will say, to anyone 
who will listen. I’ve spent more than 
20 years fixing other people’s 
problems, so I’m used to being 
called an expert, but the reality is 
that every family has its own expert.

To qualify, you just need to be the 
youngest adult in the room that owns  
a PC. Sooner or later, your grandma or 
your uncle or your sister-in-law will 
mention that their laptop is broken or 
iTunes keeps crashing and you’ll feel 
guilted into taking a look at it. Whether 
or not you ultimately manage to fix it 
makes no difference – you’ll still be the 
computer expert. After all, you’ve just 
spent a frustrating Sunday afternoon 
downloading drivers or booting in and 
out of Safe Mode, so you must know 
what you’re doing.

But this is no way to live. Nobody 
wants to be that sort of expert. It’s not 

effective and the hourly rate is terrible. 
There are people who enjoy pointlessly 
fiddling with computers, but you aren’t 
one of those people and neither am I. 
What we both want is to spend the 
minimum time fixing computers and 
the maximum time using them. It 
doesn’t matter whether you are fixing 
your own computer, doing a favour for 
a relative or even fixing computers 
professionally, the goal is always to find 
the quickest, simplest fix that works.

That’s the difference between an 
expert and a guru. A guru can listen  
to a long, rambling list of unrelated 
symptoms and decide which ones need 
fixing and which don’t. A guru Googles 
quickly for the right answer. A guru 
understands when to spend time on a 
problem and when to spend money. 
Most importantly, a guru doesn’t spend 
his spare time swapping RAM or 
reinstalling Windows – he spends it 
playing PC games. A guru enjoys all of 
the kudos of being an expert, with 
none of the hassle – and I am going to 
teach you how to be one.

Luis ViLLazon  
reVeaLs His tecH 
support secrets

Tech tips
become a guru
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                   “There is no ‘weird old trick’ that Microsoft doesn’t  
                   want you to know about speeding up your PC”  

Let’s start with your own PCs. 
You need two: a desktop and 
a laptop. The laptop should 
be cheap and the desktop 
should be mid-range. You 
may be tempted to combine 
the two and get an expensive 
laptop: don’t. The desktop is 
for games, which means you 
need a large monitor, a 
respectable graphics card and 
CPU, and good speakers. If 
you try to do this on a laptop, 
you will end up paying far 
more for the same 
performance – and using an 
external monitor, speakers 
and mouse on a laptop, just 
turns your laptop into an 
unwieldy desktop. You want 
to be able to upgrade the 
graphics card once during the 
working life of a games PC, 
and this is all but impossible 
to do with a laptop.

Once you free your laptop 
from gaming duties, you can 
get by with a £400 model that 
will do all the workaday tasks, 
such as sofa surfing, email, word 
processing and spreadsheets. 
This ring-fences the activity 
most likely to cause computer 
problems (that is, gaming) from 
all the other things you need a 
computer for, and it means that 
whichever one breaks, you’ve 

Answers at Stack 
Exchange can 
usually be trusted

How to Google
Knowing the right answer isn’t an 
especially useful skill. Being able 
to find the right answer is much 
more valuable and recognising 
the right answer when you come 
across it, is even better. 
‘Google-fu’ is a martial art that 
gets better with practise, but 
here are some quick tips to help 
you sharpen your searches.

Don’t Google the question, 
Google the answer. “Watch Dogs 
crashes randomly” will give you 
dozens of forum posts from 
complaining gamers, but the 
answers will mostly be a mixture 
of bland boilerplate advice, 
requests for detailed crash logs, 

and suggestions of things to try, 
with replies saying that this 
didn’t help. Instead, Google 
“Watch Dogs patch notes” and 
you can quickly skim the list of 
bug fixes to see if any of them 
address your problem.

Ignore search results that are 
YouTube videos. These are almost 
always just a collection of 
suggestions culled from other 
forums, and a video is much 
harder to skim quickly and the 
comments section offers very 
poor feedback to help you decide 
whether any of the fixes work.

Avoid slideshows. “8 tips to 
Watch Dogs running smoothly”  
is just a way for commercial sites 
to generate page views. Six tips 
will be generic things like 

“upgrade your RAM” and “install 
the latest drivers” and the other 
two won’t apply to you.

Use the wisdom of crowds. 
Don’t look for a single forum 
post with a definitive “right” 
answer – skim all the sites on the 
first page or two of search results 
and look for common patterns. If 
a fix is confirmed on several sites, 
it’s more likely to be reliable.

Know which sites to trust. 
Search results from 
stackexchange.com are really 
valuable as they use a rigorous 
voting system for the answers. 
Game developer forums and 
answers.microsoft.com are the 
next tier down. Sites such as 
answers.yahoo.com and answers.
com are garbage.

news just in: not everything on the internet is true

got another one to use for 
Googling solutions.

Put the desktop PC on the 
table, not the floor, and turn the 
case so it faces sideways. If you 
have it with the front facing 
towards you, like most people 
do, the rear becomes a stagnant 
tangle of cables that never gets 
dusted. Some of that dust will 
get pulled back into the case 
and coat your motherboard, 
which means the poor clearance 
interferes with case ventilation.

Back up both of your PCs 
once a month without fail. 
These should be complete 
clones of the entire hard disk 
using Acronis True Image (£40, 
acronis.com) onto an external 
USB drive that is at least as  
large as the internal drive in 
your PC. Use a different backup 
drive for each PC. 

Also, don’t keep your 
documents on the internal hard 
disks at all. Put them in cloud 
storage, like Microsoft OneDrive, 
Dropbox or Google Drive. This 
entirely saves you from the 
responsibility of backing up 
those small, important, 
frequently changing files, which 
is most of what you need a 
backup for in the first place. 
Those clone drives are just there 
for disaster recovery.

SURPRISInG ADvICe 
If you’re giving advice to others, 
it should be: “don’t build your 
own computer”. From a support 
perspective you’re just making 
things hard for yourself. It’s also 
much harder to claim on the 
warranty if something doesn’t 
work, because all the 
manufacturers will blame each 
other for any incompatibility.

Don’t ever reformat and 
reinstall Windows. This is the 
last apple at the bottom of the 
troubleshooting barrel. It takes 
ages, the PC is never the same 
after and it won’t fix the issue.  
If you’re desperate enough to 
reinstall Windows, you’re 
desperate enough to get a new 
PC – which will fix the problem. 
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Don’t update your drivers, 
either. This is the first item on 
every troubleshooting flowchart 
ever. But this is a stalling tactic 
dreamt up by customer support 
hotlines to get you to go away 
for a few hours. 

Unless you know  
of a specific bug in  
your current driver 
release you are 
personally 
experiencing and 
the release notes for the 
new version explicitly mention 
that this bug has been fixed, 
you are simply adding one 
more variable into the mix. New 
drivers are as likely to introduce 
new bugs as fix old ones.

With this foundation laid, 
your PCs will definitely never 
ever break or crash. When they 
inevitably do anyway, you will 
find that all computer problems 
fall into one of five categories.

sequence the PC gets (see the 
normal sequence of events on 
page 71). If you aren’t sure, you 
should replace the RAM, PSU, 
graphics card and hard disk – in 
that order. This is so you check 
the easiest components first, 
not the most likely. Your 
assessment of likelihood is 
probably wrong, and you’ll save 
time in the long run if you get 
into the habit of checking the 
easy things first. You might 
think a game with messed-up 
textures can only be caused by 
a faulty graphics card, but RAM 
and PSU faults can both cause 
this as well, and they are both 
much cheaper to replace.

You’ll replace some perfectly 
good components this way. So 
buy upgrades, rather than exact 
replacements. That way, all your 
wrong guesses are at least 
upgrading your PC – and you 
can hang on to the parts.

1SPONTANEOUS 
BREAkAGE

2   REPRODUCIBlE  
CAlAMITY

Clone the entire hard 
disk to get the most 
comprehensive back 
up possible

No one ever made 
their PC worse by 
adding more RAM

“It was working fine until  
I dropped it”
The first category is for 
computers that abruptly 
transition from working to not 
working. This could be the 
entire computer refusing to 
boot up at all, or it could be 
that you can’t connect to Steam, 
or maybe Watch Dogs has 
scrambled textures. It doesn’t 
matter what stopped working. 
The important part is that it 
stopped suddenly.

Spontaneous breakage is the 
easiest problem to diagnose.  
It occurs because something 
changed. Either a hardware 
component failed or you added 
something that was 
incompatible. Identify the last 
time you can definitely say  
the PC was working, and the 
problem must lie with 
something that changed since 
then. Uninstall any new software 
or restore your PC back to the 
previous full backup and see if 
the problem goes away. Then 
repeat any Windows updates 
and reinstall programs one by 
one until it returns.

If you haven’t added anything 
recently and the PC broke 
anyway, you can be sure a 
hardware component has failed. 
If the PC won’t boot, you can 
usually tell which component is 
dead by how far into the boot 

“every time I try to use it, 
it just crashes”
If you can reliably crash an 
application or generate one  
of those error messages that 
end-users were clearly never 
meant to see, then congrats! 
You have found a bug.

Finding bugs is a well-paid 
job, so if you enjoyed finding  
it consider a career in software 
quality assurance – though you 
have only found one so far, so 
don’t get too carried away. 
There is generally nothing you 
can do about a bug except 
report it to the developers (if 
they give you an easy way to do 
this) and hope and/or pray that 
it gets fixed in the next version.

In reality, it’s like voting in a 
general election: it’s your duty, 
but it doesn’t actually make any 
difference. In the meantime, 
you’ll just have to work around 
the bug, but at least you don’t 
need to waste any more time 
looking for a solution. After all, 
most of the developers won’t, 
either. (That’s satire, that is.)
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“It’s just keeps on getting 
worse and worse”
‘Badness’ nearly always means 
your PC is getting slower. And 
normally, the solution is just to 
put up with it. like promises of 
youthful skin and powerful 
erections, the solutions offered 
on the internet to speed up 
your PC are all scams for the 
feeble-minded. There is no 
‘weird old trick’ that Microsoft 
doesn’t want you to know about 
for speeding your PC up. 
Microsoft is extremely invested 
in making your PC run as well  
as possible, and if removing old 
entries from the Registry made 
a significant difference, 
Windows would already do it 
for you automatically.

You can make your PC run a 
little faster by upgrading your 
RAM to the maximum it 
supports, removing programs 
from the start-up group 
(especially your antivirus 
software) and uninstalling 
programs you don’t need. But 
most of the slowdown comes 
from the inexorable bloating 

from Windows updates 
building up over time. If 
you want a noticeably 
faster PC, buy or build a 
new one.

People complain heat 
output has got worse over 
time – especially from a 
laptop. Older laptops run 
hotter because they are 
trying to run newer 
games on older 
hardware, so the CPU 
and graphics card are running 
at full power often. They have 
also collected dust on the 
motherboard and fan blades, 
which interferes with cooling. 
You can’t do anything about 
the former, except upgrade.  
I’d argue you shouldn’t do 
anything about the latter either. 
I’ve never dismantled a laptop 
and felt things were in better 
shape afterwards.

If your laptop is running 
hotter, don’t use it on the bed, 
and hope the graphics card 
doesn’t blow before it’s time to 
upgrade. Remember, heat by 
itself isn’t really a problem. 

Avoiding the experts

The guy in the shop  
is not a computer 
expert. He’s just 
someone with good 
interpersonal skills. If 
your mum wants to 
set up her Gmail 
account in Windows 
Live Mail, he can help. 
If you come to him 
with your weird Blue 
Screen error, you’ll be 
given some misleading 
flannel and then 
steered towards a sale.

The woman in the 
call centre is not an 
expert, either. She’s 
working from a 
troubleshooting 
flowchart of simple 
solutions to common 
problems. Her goal is 
to get rid of you as 
quickly as possible, so 
she can keep her call 

stats up. These are not 
bad people, they just 
aren’t the droids 
you’re looking for.

There aren’t really 
any experts anywhere. 
There are just people 
who have come across 
the same problem as 
you, and people who 
haven’t and are 
guessing loudly. To be 
a Tech Guru you need 
to start filtering out 
this noise. 

The only reason for 
visiting a computer 
shop is to see if you 
like the keyboard on  
a specific laptop. The 
only reason for 
ringing a customer 
support line is for 
broadband connection 
problems. everything 
else you must fix 

yourself, armed only 
with the internet.

Online is the only 
place you are likely to 
come across honest 
answers. In the real 
world the people who 
know them are tucked 
away doing well-paid 
jobs far away from 
grubby customers.  
But online you can get 
their help for free.

Don’t waste time 
soliciting it directly. 
Skim forums for 
similar questions and 
triangulate the 
suggestions from the 
most well-informed 
replies. If your 
problem is common 
enough, someone else 
will have asked. If it 
isn’t, you won’t find 
the answer by posting.

How to avoid being fobbed off and 
brow-beaten by the well-meaning clueless

3CREEPING 
BADNESS

 Abrupt game crashes  are usually bugs in the game or its mods 

 Don’t try and level  
 your PC up, like a  
 character in an MMO
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“I’m sure it’s infected”
I have learned to listen to the 
symptoms, not the diagnosis. 
Some people are convinced 
their PC is constantly under 
attack and see every 
unexplained behaviour or error 
message as irrefutable evidence 
of a virus infection or a hacker. 
If you are one of those people, 
then stop it! 

Provided Windows is updating 
automatically and you have 
changed the admin password 
on your broadband router from 
the factory default, avoiding 
viruses and hacking is mostly a 
question of not being an idiot 
when you click links. 

If your browser homepage has 
changed by itself, or you can’t 
open google.com, then you may 
have a browser hijack. This is 
malware, but it isn’t a virus or 
Ebola. Download the Microsoft 
Malicious Software Removal 
Tool and be done with it.

4RANDOM 
WEIRDNESS

5OMINOUS 
PORTENTS

 If your laptop runs hot  
 while gaming, that’s  
 quite normal 

On the other hand, if it 
reboots five times a day then 
this is frequent enough not to 
count as random, and more to 
the point it’s damned annoying. 
You can treat this sort of fault 
as Spontaneous Breakage and 
take appropriate measures by 
referring to that section.

Removing start-up 
junk is one of the 
few go-faster tips 
that works

“Sometimes it just freaks out 
for no reason at all”
There are three kinds of random 
fault: loose connections, 
overheating and memory errors. 
You can tell the difference quite 
easily. If it freaks when you pick 
it up, it’s a loose connection: 
some component or wire 
internally isn’t quite making the 
connection it’s supposed to be, 
or at least isn’t doing it reliably.

If it freaks when you’ve been 
watching films or playing games 
for a while, perhaps 
accompanied by overly 
enthusiastic fan noise, it’s 
overheating. Everything else is a 
memory glitch. You can fix 
memory glitches by replacing 
RAM and the other two kinds 
usually can’t be fixed, so 
you should just replace 
the RAM anyway, in 
case you were 
wrong about which 
kind you have.

Random weirdness 
that happens only extremely 
occasionally isn’t worth doing 
anything about. For instance,  
if my PC reboots itself 
spontaneously once a week, I 
would rather take a few calming 
breaths and get on with my life 
than waste several days hunting 
down a fault that is extremely 
hard, if indeed possible, to 
reliably reproduce.
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Learn to program
Programming is an 
extremely helpful skill  
for a Tech Guru. Lots of 
command line operations 
become easier if you know 
a little programming, 
particularly in Linux – but 
much more importantly,  
it teaches you what a 
computer really is.

Programmers are like 
neo: they don’t see files 
and icons, they see 
resource handles. Memory 
isn’t just a quantity, like 
the fuel in your tank. It’s  
a collection of discrete 
integers and floats and 
strings. When you 

understand how the 
house is built, 
you’ll know which 
walls you can 

safely remove and which 
will bring the ceiling down 
on your head.

Programming means 
debugging, and the 
mindset you for it is the 
same as for diagnosing 
every other computer 
problem. Programming is 
like classical music theory 
for computer 
troubleshooting. You can 
teach yourself to strum 
some chords without it, 
but you won’t become a 
great musician that way.

As soon as you can write 
a simple program, more 
complicated programs lose 
their mystique. And if you 
can write even a modestly 
useful app or a mod for a 
game, then your computer 

itself will be demystified to 
a degree that’s impossible 
to overstate. Programming 
is such a useful skill that it 
should be compulsory for 
all five-year-olds, never 
mind aspiring Tech Gurus.

Happily, programming 
is easier to learn now than 
ever. Python is a good 
language to learn first – 
it’s a widely used, serious 
language, but designed to 
be readable and simple.

You can learn the basics 
for free in a few weekends 
at developers.google.com/
edu/python and 
learnpythonthehardway.
org. (Don’t be put off by 
the ‘hard way’ part.) If you 
can complete a sudoku you 
can learn Python.

it’s like pilates for your brain

– and by the time it does, your 
upgrade might not be graded 
far enough up. Secondly, you 
need to know when to upgrade 
the components and when to 
upgrade the PC.

here’s what I do. With every 
other version of Windows, I will 
buy a new desktop or laptop 

with that version preinstalled. 
On the odd-numbered releases 
of Windows, I’ll just upgrade the 
existing machine. When I buy a 
PC, I’ll specify one notch above 
the current mid-range for CPU 
and graphics card, and get the 
maximum RAM that Windows 
currently supports. I normally 
get whatever the default hard 
disk size is at the time. After a 
year, if I want to run an 
application that needs more 
RAM or a faster graphics card, 
I’ll upgrade. If it needs a faster 
CPU, I’ll get a whole new PC. I 
have never run out of disk space 
on any PC ever.

A very common question for 
a Tech Guru is “Which new 
laptop do you recommend?” 
And the correct answer is to 
look at Windows help & Advice 
magazine. The magazine 
regularly reviews laptops, 

Learning Python is 
straightforward, 
useful and free

Do you really need 
to upgrade it? 
Really? Think now 

“I just want to try out the 
latest cool thing”
A PC is like a character in an 
MMO. When you start at level 
one, you fight wolves and 
gradually you upgrade your 
equipment and can take on 
several wolves at once. But no 
matter how powerful you 
become, there will always be 
new gear you could get, and 
Chromium Ultra-wolf Den 
Mothers that you could be 
fighting. Rainbow-chasing is 
when you make life hard for 
yourself by trying to fix 
problems that don’t exist. 
Overclocking your PC, just to 
get a bigger number in your 
benchmarking tool, say, or 
configuring a RAID0 array of 
disks, when hard disk 
performance isn’t even a 
bottleneck for you. A lot of 
“What’s the best way to 
upgrade?” type of questions are 
examples of rainbow chasing.

Upgrading is generally a good 
thing but there are two pitfalls 
you need to watch for. Don’t 
upgrade your PC for the sake of 
it. You should upgrade so that 
you can run new software that 
exists now. Not so you’ll be 
ready for any new software that 
might come along in the future. 
You can’t tell how long it will be 
before something comes along 
that you need new hardware for 
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tablets and sometimes full PC 
desktop systems. You’ll also find 
many other gadgets represented 
in our pages. This leaves the 
question of how much you 
should pay for such things. The 
right price for a graphics card is 
£200. For a laptop, it’s £400 for 
a basic machine and £1,000 for 
a fancy one. For a motherboard 
it’s £100, although the only 
reason to upgrade is when you 
upgrade the processor as well, 
and if you are doing that, you 
may as well look at a whole new 
machine – that way you’ll get a 
much better PC, with less hassle.

HeLPInG OTHeRS 
As a Tech Guru, you have to  
do more than diagnose the 
problem. You must also consider 
who is asking for your help and 
choose the best solution. By 
that, I of course mean the best 
solution for you.

For family members, you need 
the quickest resolution, because 
they will come back to haunt 
you if you don’t fix it on the first 
try. Swapping RAM modules 
around is a quick and safe thing 
to try, but reformatting and 
reinstalling Windows will be 
much like cutting the head off  

a hydra: you may fix the original 
problem but three more will 
grow in its place, as you try to 
restore all the drivers for their 
15-year-old printers and 
off-brand sound cards.

With friends and neighbours 
you are much less invested, so 
wherever possible you should 
recommend new kit. My 
experience is that this is 
generally what they are hoping 
you will do anyway. Your 
pronouncement will be used as 
bargaining leverage with their 
spouses or parents, to justify  
a big spend. If you try and save 
them money, they will resent 
you for it and the next time 
their PC breaks, you’ll be 
blamed for not euthanising  
it last time.

What should happen
When your PC is switched off 
but still plugged into the mains 
(or laptop battery), the 
motherboard still receives 
power on the 5-volt standby 
rail, providing power to the 
circuitry that monitors the 
power button.

Pressing this button signals 
the motherboard to tell the 
power supply (PSU) to fire up 
and pulls the voltage to 0v on 
the reset pin for the CPU. This 
puts the CPU into a known start 
state, with default values 
loaded into all the registers, 
and sets the instruction pointer 
to the start address of the BIOS.

Between 0.1 and 0.5 seconds 
later, the voltages from the PSU 
have stabilised and it signals 
this by putting +5v on the 
Power Good line. The tells the 
motherboard to release the 
reset line, which allows it to 
return to +5v.

The CPU begins executing 
the Power On Self Test (POST) 
in the BIOS or UeFI code. This 
initialises the RAM and the PCI 
bus. If there’s a problem you’ll 
receive a series of beeps – a 
single beep indicates a pass, 
and control then passes to the 
video card, which executes its 
own video BIOS initialisation 

routine. Once the video 
subsystem is working, control 
comes back to the BIOS or UeFI 
and you’ll see a summary 
screen or pretty splash screen.

While this is displayed, each 
drive is checked until it finds a 
bootable one. Control passes to 
the boot loader program stored 
on this disk, which copies the 
Windows kernel and basic 
drivers into RAM. The Windows 
logo appears, the boot loader 
copies the registry into RAM 
and loads remaining drivers. 
The boot loader hands off to 
the Windows kernel and the 
login screen appears.

understand a normal boot sequence to recognise anomalies

If you are fixing computers for 
customers, your overriding 
priority is to safeguard their 
data. Before you so much as 
open Device Manager, you 
should clone their entire hard 
disk onto a removable drive of 
your own. This will feel like a 
ridiculous precaution every 
single time, until you actually 
need it, whereupon it will feel 
like the best advice anyone has 
ever given you. Remember: if 
data is lost for any reason while 
you are sat in front of the 
keyboard, you will be blamed. 
Cloned hard disks are like save 
points: you can afford to be 
more adventurous, if you know 
you can hit F9 and reload.

Is that all? Are you really a 
Tech Guru now? Of course you 
are! Gurus don’t have all the 
answers, they just know how to 
remain calm under fire while 
they look for one. They know 
where to look and they know 
the answer when they see it. You 
can do all these things and all 
that you need now is the 
self-confidence to carry it off. 

If anyone tries to call you an 
expert, by all means deny it. But 
if they call you a guru, just smile 
knowingly and humbly. ■

If you can boot this 
far, the motherboard 
is probably fine
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 WINDOWS HELP  HARDWARE FIXES  SOFTWARE SOLUTIONS  INTERNET TIPS

Windows
WINDOWS STUck AT 
STARTUP REPAIR 

Q I switched on my Windows 7 
PC after the latest round of 

Windows Updates and now it’s 
stuck in a loop whereby it goes to 
Startup Repair, which attempts 
unsuccessfully to repair files before 
rebooting again. It’s pretty 
frustrating. Please help – what 
should I do to break the cycle?
Simon Jethwa

Graham’s solution
This regrettable 
behaviour can occur 
when a single update 

corrupts for some unknown reason 
during the update process. Fixing it 
is usually as simple as waiting for 
the start-up repair to fail, then 
choosing System Restore from the 
list of available repair options.

Simon never got this option, so 
we tried to steer him towards an 
option on Startup to access 

recovery options, which he couldn’t 
find either. He then managed to 
find a Windows 7 repair disc, but  
on running it discovered that 
System Restore was unable to 
restore the computer using the 
Restore point taken before the 
update occurred.

At this point, Simon confessed 
that his computer had been 
unstable for some time. So it was 
increasingly clear that the 
installation was corrupt – it’s 
possible that a timely use of the 
Check Disk tool or System File 
Checker would have caught and 
fixed the problems before they 
spread, but now the only solution 
was a clean install. 

Sadly though Simon had no 
backups in place. So we pointed 
him towards our “Recover data if 
your PC fails” tutorial from issue 94, 
and this allowed him to take a drive 
image of the computer – thus 
crucially saving all the data on it – 
prior to reinstalling Windows from 
scratch. So Simon is now being 
thoroughly schooled in the art of 
backing up his PC!

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

RepaiR WindoWs 
system Restore 

can usually undo 
corrupt updates
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Email
STRANGE OUTLOOk 
REcEIvE ERROR 

Q I recently updated to Outlook 
2013 (but this problem still 

occurs in Outlook 2007), and I keep 
getting a Send/Receive error 
message, even though I appear  
to be receiving email with no 
problem. When I investigate under 
Tasks, I get receiving errors 
(0x80042108) against my address. 
But then it says “complete” next to 
my email address with (1) after it.
colin Forster

Matt’s solution
The clue to the answer 
lay in the (1) – this 
indicates that a second, 

duplicate email account has been 
created in Outlook – the one that’s 
currently working. There will be 
some minor tweak to the security 
settings that means this account 
works while the original one 
doesn’t. All Colin needed to do was 
open Account Settings from the 
File tab, where he should see both 
accounts are visible. Select the first 
one and click Remove, then rename 
the second to remove the trailing 
(1). Once done, Colin confirmed the 
error messages had ceased.

Hardware
NEW Pc WON’T PLAy  
My DvDS 

Q I’ve just bought an Acer Aspire 
PC, but can’t play DVDs. It will 

play music discs, however. Could 
you advise me on what external 
DVD or Blu-ray player to get that 
will play DVDs?
Royston Greenwell

Mayank’s solution
At first we thought this 
was a simple software 
problem to do with 

playing DVD films – Windows 8 no 
longer ships with a DVD player, so 
you need to download a third-
party tool for the job, such as VLC 
Media Player (videolan.org). 
However, in the course of our 
correspondence with Royston it 
quickly became apparent this was a 
bigger problem: the drive wouldn’t 
read or play any DVD discs – data or 
video, although it could still 
recognise and play CDs. This is 
symptomatic of a hardware failure 
whereby the laser diode used for 
reading and writing DVDs isn’t 
working – Royston got on to Acer 

Quickfire questions

Find the solution! Microsoft Fix It Solution Center
Visit support2.microsoft.com/fixit to access a number of 
diagnostic and fix-it tools for Windows, Office and more.

I’m looking for a good musical 
notation tool. Can you 
recommend one?
Tim Wilson

MuseScore (musescore.org) is 
the best free tool out there – 
and version 2 had just been 
released with lots of new and 
improved features. We 
featured it back in issue 87.
 
I tried to format a memory 
stick but got the message,  
“This disc is write-protected”.
Joe Pester

We contacted Joe with several 
suggestions – the good news 
was he’d inadvertently 
knocked the drive’s write-
protect switch. Flicking it back 
to off solved the problem.

“This is a hardware 
failure, where the laser 
diode isn’t working”

 Laser diode 
The semiconductor laser  
reads and writes optical discs. 
Burners have two lasers: 
infrared for CDs, red for DVDs.
 

 key logger
A program that covertly 
records keystrokes, usually for 
malicious intent, such as 
password stealing. 

duplicate entRies  
a (1) indicates you’ve two 
identical accounts set up

BRoken laseR  
if your dVd drive only 
recognises cds you’re 

in trouble

Support 
Technical help
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2 choose what to edit
When prompted for which settings to 

edit, choose ‘File Type Settings’. At the next 
screen, click ‘Context Menu’ to edit the 
contents of a file type’s context menu, then 
scroll through the list (or use the search tool) 
to locate the file type.

1 Download and run
Go to defaultprogramseditor.com  

and download Default Programs Editor. 
Right-click the downloaded file 
(DefaultProgramsEditor.zip) and choose 
Extract All. Open the newly created folder 
and launch Default Programs Editor.exe.

ADD cUSTOM ‘OPEN 
WITH’ OPTION TO 
cONTEXT MENU

Q What happened to the File 
Types tab in Folder Options?  

I want to add a custom ‘Open in’ 
option to the menu that appears 
when a PNG file is right-clicked. 
John Rostron

Nick P’s solution
The feature was 
removed from Vista.  
If the new ‘Open with’ 

menu isn’t to your taste – John 
wanted a simple, one-click 
alternative to the default option, for 
example – then follow this guide.

Quickfire questions

Windows
PRObLEMS WITH  
SAFELy REMOvE 
HARDWARE bUTTON 

Q Every time I click the Safely 
Remove Hardware and Eject 

Media button in the Taskbar, 
nothing happens. I’ve created a 
shortcut on my desktop as a 
workaround, but it’s not the same. 
Can you help? I’m running 
Windows 7 on a Dell laptop.
Andreas christou

Nick P’s solution
There are a number of 
fixes you can try – you 
could, for example, 

check that the ‘Devices and 
Printers’ shortcut on the Start menu 
is working correctly. If it’s not, then 
check the Bluetooth Support 
Service is running by clicking ‘Start 
> Run’, typing services.msc and 
pressing [Enter]. Scroll down – if it’s 
not, restart the service and set it to 
‘Automatic (Delayed Start)’. This 
should bring back both. 

If this fails, it’s worth clicking the 
button and waiting, for perhaps up 
to a minute – if the list eventually 

Am I correct in thinking a 
Windows installation can be 
installed on two PCs you own? 
I wish to put Windows 7 on  
my XP laptop.
Andrea Quinn

Unfortunately not – previous 
versions of Office could be 
installed on a desktop and 
laptop in this way, but not 
Windows 7 unless you 
purchased a Family Pack 
version, which can be installed 
on up to three PCs.
 
What’s the simplest way to 
transfer the photos on my 
Moto G phone to my PC?
Darren Pink

Use a cloud storage provider as 
an intermediary – apps such as 
Dropbox or OneDrive allow 
you to automatically sync 
photos to your storage, which 
can then be synced to your PC 
and other devices in turn.
 
My PC’s stopped playing  
audio – can you please help 
me to troubleshoot?
Art Evans

Visit support.microsoft.com/
mats/audioplayback where 
you’ll find a handy tool that 
can diagnose and fix many 
audio-related problems, 
including issues with hearing 
sounds in Windows.

who responded by arranging a 
pickup and repair of the computer. 
Before sending it off, however, we 
advised Royston to back up any 
data first – just in case the entire 
computer ends up being replaced 
as opposed to just the drive itself.

Email
SPAM SURGE 

Q After returning from holiday 
– where I had to check my 

email using my iPad and Nokia 
phone – I’ve discovered my home 
PC has suddenly started seeing  
a deluge of spam mail, at least  
a dozen per day. Could this be 
indicative of a key logger on  
my system?
John buchanan

Matt’s solution
It’s unlikely an infection 
is to blame in this 
instance. Your first port 

of call should be your own email 
settings – check both the program 
you use and your online settings 
with your ISP. John checked his and 
found a couple of settings had 
been changed, which explained the 
problem: one no longer 
automatically filtered spam to the 
spam folder, and another had 
stopped putting a clear “SPAM”  
at the beginning of mails suspected 
of being spam.

John was understandably 
concerned at how these settings 
had changed in the first place – 
when something strange like this 
happens, it’s a good idea to change 
your email password, just to be on 
the safe side. 

Also, in the longer term, perhaps 
use a password manager such as 
LastPass (lastpass.com) to manage 
your passwords – this encourages 
you to use more complex 
passwords without locking yourself 
out of your accounts.

safe RemoVal 
the quickest way 
to remove a  
usB drive is to 
right-click it
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 SNMP 
Stands for Simple Network 
Management Protocol, and is 
used to manage networked 
devices on a local network, 
including computers, routers 
and other peripherals.
 

 Silverlight
Microsoft’s alternative to 
Adobe Flash is an application 
for allowing developers to run 
media, streaming and other 
graphics in a web browser 
through a plugin. 

4 Final tweaks
Click the expand button next to 

Advanced Settings. Set ‘Item scope’ to ‘Only 
this extension (.png)’, then click ‘Next’. You 
should see the option appear in the list –  
click ‘Save Context Menu’ followed by ‘OK’  
and ‘Close’ to finish.

3 Set up basic action
You’ll see a list of existing context menu 

entries – click the ‘Add…’ button to create  
a new one from scratch. Next, type the 
command name (as it’ll appear in the context 
menu), then click Browse to select your 
particular target program.

“There’s a simple solution – Microsoft has a 
Silverlight clean-up tool that enables you to 

remove all traces of the software”

appears then it could be linked to a 
networked printer. 

To sort this out, open ‘Devices 
and Printers’, select the printer and 
click ‘Print server properties’. Switch 
to the Ports tab, select ‘Standard 
TCP/IP Port’ and click ‘Configure 
Port’, then untick ‘SNMP Status 
Enabled’. Click ‘OK’ twice and the 
problem should be solved.

If neither of these circumstances 
are relevant, then simply bypass the 
‘Safely Remove Hardware…’ button 
altogether – instead, click ‘Start > 
Computer’, right-click the offending 
device and choose ‘Eject’. Andreas 
was pleased to report this method 
worked perfectly.

Printing
LOST WIRELESS PRINTER 
cONNEcTION 

Q We have a HP Pavilion G6 PC 
and HP 4500 wireless printer. 

These have been working fine, but 
we seem to have lost the wireless 
connection between the two. 
We’ve uninstalled, removed 
everything, reconnected and then 
run the disc – everything seems  
to install smoothly, but when we try 
to print nothing happens. Are you 
able to help?
Max and Susan Green

Nick O’s solution
Max and Susan were 
able to confirm that 
another PC was still able 

to print to the printer wirelessly, 
which allowed us to focus our 
attention on the Pavilion G6 itself.

Other HP users have reported 
fixing this problem by physically 
connecting the printer to the PC 
using a USB cable. Once the PC’s 
detected the printer via USB, you 
should be able to disconnect the 
printer and try printing wirelessly 
again. Unfortunately Max and 
Susan haven’t yet responded to this 

suggestion of ours, so we can’t 
confirm whether or not it resolved 
their problem – please do let us 
know when a solution has been 
found, so we can share the method 
with other Windows users.

Internet
SILvERLIGHT UPDATE 
PRObLEM 
Q I’ve been plagued by a failed 

Windows Update – one that 
attempts to update Silverlight. It’s 
gone on for months, so in the end  
I attempted to uninstall Silverlight 
only to be told the feature I’m 
trying to use is unavailable.
Theresa Unwin

Graham’s solution
Thankfully there’s a 
simple solution to this 
irritating problem – 

Microsoft provides a handy 
Silverlight clean-up tool that will 
enable you to completely remove 
all existing traces of the software.

You’ll find this tool at support.
microsoft.com/kb/2608523 – scroll 
down the page and click the 
Microsoft FixIt button. If prompted, 
you should choose to open it with 
the Diagnostics Troubleshooting 
Wizard. Alternatively you could 
save it to your hard drive and 
double-click Silverlight.diagcab to 
run it manually.

Follow the wizard through and  
it should result in Silverlight being 
finally purged from your system. A 
little lower on the same web page 
you will find a link to the latest 
version and, hopefully, once this is 
installed, Windows Update will 
deliver future updates without any 
further problems.

RemoVe 
silVeRlight 
microsoft offers a 
fix-it tool to purge 
silverlight from 
your pc

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 
Windows Help & 
Advice magazine, 
Future Publishing Ltd, 
Quay House, The 
Ambury, bath  
bA1 1AU

Support 
Technical help
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well, summer is 
nearly here, which 
for us folks at at 
Windows Help & 
Advice is both a 

good thing and a bad thing! 
With the sun shining and the 
birds singing merrily, we need 
to tear ourselves away from our 
PCs and get outside. Luckily, 
the Fitbit Surge offers 
something we can have fun 
with while also getting fit – see 
page 86 for more.  
     However, for when the sun 
goes down, we’ve put some 
seriously great hardware to the 
test. There’s no less than eight 
headphones to choose from, as 
well as the new device from 
ASUS. We also have some great 
games, too. Until next time!

Nick Odantzis deputy editor
nick.odantzis@futurenet.com

Welcome

how we review
One of the key tenets of our 
review philosophy is that 
hardware should be compared 
against like products wherever 
possible. It is only when you pit 
the finest products of a certain 
type against one another – at 
the same time – that you can 
really come up with a definitive 

verdict as to which is the very 
best in that category. The pace 
of development in computer 
hardware means that it is very 
difficult to compare scores 
from today with those from, 
say, six months ago. Magazines 
and websites that review a new 
product on its own run the risk 
of confusing or misleading.

We guarantee to test every 
piece of hardware rigorously 
and thoroughly, using only 
acknowledged experts to 
establish the worth of a 
product. We always review 
from the viewpoint of our 
readers; the day-to-day 
practicality and quality of  
a product is paramount.

We use only acknowledged experts to review products, so you can use 
our ratings with full confidence to make your buying decision

ratinG explained Superb GoodVery good Disappointing Poor

our awards…Our review guarantee
Only the very 
finest products 
receive our Best 
On Test Award. 
These will have 
excellent marks 
for quality.

Our Best Value 
Award is given 
to products that 
quite simply 
represent the 
best value for 
your money.

84 SanDisk Connect Wireless  
Flash Drive
SanDisk’s innovative USB stick has built-in 
Wi-Fi, but does that justify the price?

78 Gaming headsets
Whether you’re gaming, Skyping or 
watching a film, we’ve got the headset for 
you – we test eight of the best

88 Evolve
The new game is a crossbreed of co-op  
and competitive FPS and a jetpack dance 
between prey and predator

82 ASUS Transformer Book  
T300 Chi
With 2-in-1 laptops getting skinnier all  
the time ASUS has taken things further
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Upgrade 
What’s inside…

Upgrade 
What’s inside…

You can trust our reviews
Our expert reviewers are 100 per cent 
independent, with years of experience 

in the world of computing. Our rigorous 
testing procedures mean that only 
genuine, high-quality products are 
awarded high star ratings. Further, very  
few are handed our Best Value or Best  
on Test Awards. If you see an item of 
hardware bearing one of these marks,  
you can be confident that it is an excellent 
product. Always check when the award  
was given, to ensure it is still up-to-date.

we choose the best products
Thousands of new products for your 
computer are released every year and 

choosing between them can sometimes be 
an impossible task. Our experts select only 
the best hardware and software to feature 
in this magazine, making your decision on 
which one to choose easier. Even better, 
our awards and star rating system make it 
simple to find the best products for your 
needs, with our recommended products 
section giving you a fast, trustworthy guide 
to a wide range of hardware and software.

we’ll introduce you to new stuff
Wherever we can, we review new 
hardware comparatively, pitching  

it head-to-head against other similar 
products. (Full details of our policy can be 
found in the opposite page, under ‘Our 
review guarantee’.) Of course, this isn’t 
always possible with new products and 
part of our duty to you is to introduce you 
a wide range of fascinating new hardware, 
software, services and games.

The reviews of standalone hardware  
and software are just as thorough as our 
comparative reviews. However, we do not 
allocate scores to them because this can 
often be misleading. The only exception to 
this rule is on our games reviews, where 
the pace of change is a lot slower and 
single scores can be genuinely useful.

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC
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“There’s even a
beam weapon – like a

Ghostbusters proton pack” 
Turn to page 90

82 The latest machine 
from ASUS takes skinny  
to a whole new level

Our promise to you…

86 It’s time to  
get fit (and stylish)  

with the Fitbit Surge

78 Gaming headsets
82 ASUS Transformer Book T300 Chi
84 SanDisk Wireless Flash Drive
86 Fitbit Surge
88 Evolve
90 Call of Duty
92 Grow Home
94 Gravity Ghost
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Someone at Cooler Master 
obviously felt the need for 
more noise during the design 
phase for the Sirus-C headset, 
and so threw another pair of 
drivers into these CM Storm 
cans. That means each pillow-
soft ear cup has two separate 
drivers in it – a 44mm one for 
the mid-range and treble, 
then another 40mm woofer 
to hound your ears with bass 
notes. Because of the extra 
sound-processing and amp 
tech, these cans come in at a 
weighty 425g. It’s lucky the 
build quality is so good and 
the padding so ample…

What do those separate 
drivers mean then? Well, let’s 
be clear, the audio from the 
Sirus-C is good, but it’s not 
really noticeably better than 

a decent single driver set-up. 
The standard frequency 
response range means  
while the sound is clear both 
at the top and bottom, it 
doesn’t produce the depth 
offered by single-driver sets 
with a wider range.

The microphone is a little 
underwhelming – a bit like 
the Sirus-C as a whole. It’s a 
competent headset, but 
despite the impressive specs 
it doesn’t reach the extra 
heights you might expect.

CM Storm Sirus-C 

The pro-audio outfit 
Audio-Technica’s fancy 
ATH-AG1 headset is all about 
sound quality. This is the 
audiophile brand’s first 
venture into gaming audio 
and the impressive cans 
boast some of the best 
in-game sound we’ve heard 
from our PC. The AG1’s 
concession to gaming means 
it has the exaggerated bass 
that we’ve come to expect 
from such headsets, but it 
doesn’t come at a cost to the 
rest of the aural experience. 
The high notes are crisp and 
the frequency response 
range offers an impressive 
depth to the sound. The mic 
is fantastic too. 

But it’s not all about 
sound, because if they won’t 

rest on your head 
comfortably then they’re are 
simply no good for extended 
use. The Audio-Technica cans 
use a Wing Support 
Mechanism to rest this 
lightweight headset on your 
head, which is great if the 
size of your head fits in with 
the design. But, those with a 
slender skull, may struggle to 
find them comfy. So, while 
the sound quality matches 
the high price tag, the overall 
design might not.

vITAl STATISTICS
Manufacturer Audio-Technica 
Frequency response 20Hz-20KHz
Weight 310g
Connection USB and 3.5mm wired

Audio-Technica ATH-AG1 
Price £232, www.audio-technica.com

Price £69  http://gaming.coolermaster.com

gaMing Headsets
Whether you’re gaming, Skyping or watching a movie, 
we’ve got the headset for you – here are eight on test

vITAl STATISTICS
Manufacturer Cooler Master 
Frequency response 20Hz-20KHz
Weight 425g
Connection USB and 3.5mm wired
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Gamdias Hebe 
Price £35 www.gamdias.com

With Gamdias offering the 
Eros for a bargain £46, what 
can we say about the 
even-cheaper Hebe? For a 
start, it hasn’t really got the 
hang of styling PC 
peripherals for anyone 
over the age of 17, with 
glossy red colour 
dominating these cheapish 
looking cans. We can also 
say that this isn’t a headset 
for you if you like to 
preserve your eardrums 
and not perforate them.

However, aurally, the 
Hebe is as much of a 
surprise as its big brother 
Eros. The sound quality is 
similarly excellent, with a 
virtual soundscape that’s 
crisp and effective enough 
to allow you to place audio 

sources with impressive 
accuracy. We don’t know 
what Gamdias’ magic 
formula is, but it has 
managed to create a pair of 
budget-priced headsets 
that do away with 
unnecessary gimmicks and 
just deliver genuinely 
impressive audio. This 
3.5mm jack connected set 
is slightly cheaper than the 
USB-cabled Eros, but the 
sound is almost as good.

This bargain-priced headset 
from peripheral newcomer, 
Gamdias, is a bit of a 
surprise. On first sight it 
looks every bit the £46 
gaming headset – all glossy 
red and black styling with a 
fat, pivoting boom mic. It 
doesn’t scream quality. But 
throw it over your ears and 
you’ll be stunned at the 
level of audio loveliness.

The Eros combines bold, 
pounding bass notes with 
pin-sharp treble, making it 
a great headset for gaming 
or chatting. It only rocks a 
modest 20Hz-20KHz 
frequency response range, 
but sounds almost as good 
as sets costing twice as 
much. Despite the 
questionable appearance, 

the cans are comfortable 
and cushion your head in 
gentle padded luxury.

The mic is nothing to get 
excited about, but it doesn’t 
let the Eros down. The 
audio quality isn’t quite so 
astounding musically, with 
treble feeling just a little 
too harsh for some vocals. 
Yet for a well-priced 
headset, you can’t really ask 
for more than what 
Gamdias has delivered.

Gamdias Eros 
Price £46  www.gamdias.com

vITAl STATISTICS
Manufacturer Gamdias 
Frequency response 20Hz-20KHz
Weight 310g
Connection USB wired

vITAl STATISTICS
Manufacturer Gamdias 
Frequency response 20Hz-20KHz
Weight 372g
Connection 3.5mm wired
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When we first saw Kingston’s 
HyperX-branded headset 
there was a twang of 
recognition in our minds. It’s 
effectively QPad’s excellent 
QH-90 headset but with a 
little bit of a paint job. 
However, this time Kingston 
has also turned up the dial on 
the bass.

To our surprise, it hasn’t 
taken anything away from 
the original headset’s aural 
quality. Our one concern with 
the QH-90 was the bass 
response was a little light 
because of the delightfully 
balanced EQ the QPad had 
used. Kingston has 
augmented the low-end of 
this HyperX version to give 
the sub-20Hz frequencies a 
punch that is more felt than 

heard. It’s not punching your 
ear like the Mad Catz cans, 
but adds depth to the bass 
notes without muddying 
other sounds.

And because it’s practically 
identical to the QH-90 set, it’s 
got an elegant, robust and 
lightweight design that feels 
comfy after long periods of 
use, and the detachable mic 
is as clear as you could want. 
Incredibly, Kingston has 
improved on an already 
impressive headset.

Mad Catz  FREQ 4D 
Price £94  http://madcatz.com

Kingston HyperX Cloud 
Price £86 www.kingston.com

vITAl STATISTICS
Manufacturer Kingston 
Frequency response 15Hz-25KHz
Weight 350g
Connection 3.5mm jack

vITAl STATISTICS
Manufacturer Mad Catz 
Frequency response 20Hz-20KHz
Weight 306g
Connection USB and 3.5mm wired

Thanks to Mad Catz, you 
can now get mighty close 
to total sound immersion 
with its viviTouch tech. 
Terrifying if you’re gaming, 
even worse if you’re on 
Skype with someone who 
likes to speak loudly. 

The idea with these cans 
is when you get low-end 
sounds passing through the 
ear cups, you get a palpable 
vibration through some 
fancy harmonic distortion.
We admit none of that 
sounds pleasant on the 
page, but with viviTouch 
turned on (via a switch on 
the headset itself) you get a 
fairly satisfying bass thud. 
Unfortunately, the FREQ 4D 
is tuned towards bass-heavy 
sound, which means even 

with viviTouch shut off it’s 
difficult to flatten out the 
EQ enough to make music 
or films sound anything 
other than utterly synthetic. 
Sadly, that makes the FREQ 
4D’s gimmick rather aurally 
destructive – it is suited for 
gaming to the detriment of 
anything else.

Finally, Star Wars fans will 
appreciate the headset looks 
like it was ripped straight off 
Jek Porkins after crashing 
into the Death Star…
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The H Wireless is, obviously, a 
wireless headset and pulling 
wires out of peripherals 
always ends up adding to the 
price tag. Still, £205 is a huge 
amount to spend on a 
wireless headset, so you 
would expect something 
rather special for the money.

By and large, the 
SteelSeries headset pretty 
much delivers. The aural 
quality is impressive, with 
solid, controlled bass notes, 
clear mid-range and crisp 
treble. But it’s not exactly 
class-leading – the Kingston 
HyperX cans still stand out as 
the best-sounding in this test.

But you’re not really paying 
for audio; you’re paying for 
wireless connectivity. And this 
is where the SteelSeries set 

excels. The transmitter box 
is part amp and part 
charging station, with an 
OlED display and physical 
dial and push button that is 
simple to use. With a pair of 
li-ion batteries – one for play, 
one for charging – you’ll 
barely miss a beat and the 
12m range is excellent. It’s a 
seriously impressive kit, but 
hugely expensive.

The Z300 from Turtle Beach is 
both cheaper and lighter, 
than the SteelSeries above, 
but sadly it’s not quite 
capable of delivering the 
sort of aural experience 
you’d expect from a £156 
set of cans. 

The wireless setup itself 
isn’t the problem. With 
dual-band Wi-Fi you get 
almost the same range as the 
pricier SteelSeries headset, 
and there is Bluetooth pairing 
if you are keen to link up to a 
separate laptop or mobile 
device. The Turtle Beach 
headset only comes with a 
single battery, so you’ll have 
to rely on USB for charging. 

The audio doesn’t stand 
out from the likes of the 
bargain-priced Gamdias cans 

we’ve reviewed here. The 
virtual 7.1 surround sound 
does an okay job of offering 
a more expansive 
soundscape than plain old 
stereo, but only to the extent 
of giving you a bit of a 
separation between the front 
and rear noises. That 
underwhelming feeling 
extends to the general sound 
quality – big noises sound 
fine, but then they do on the 
Hebe headset too… for a 
quarter of the price.

SteelSeries  H Wireless 
Price £205  www.steelseries.com vITAl STATISTICS

Manufacturer SteelSeries 
Frequency response 20Hz-20kHz
Weight 324g
Connection Wireless

Turtle Beach  EF Z300
Price £156  www.turtlebeach.com

vITAl STATISTICS
Manufacturer Turtle Beach 
Frequency response 20Hz-20KHz
Weight 319g
Connection Wireless
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T  he 2-in-1 laptops have come  
a long way over the last  
few years and are now 

considerably less bulky and clunky. 
However, Asus has gone one 
further with the Transformer Book 
T300 Chi, one of the thinnest 2-in-1 
machines ever created. 

The machine’s guts are stashed 
behind the screen, which lifts away 
from a Bluetooth keyboard base  
to be a standalone tablet. But by 
choosing a fanless Intel Core M 
setup, Asus has delivered a 
convertible laptop that’s even 
thinner than some tablets. Don’t 
mistake this machine’s svelte profile 
for lightweight performance, 
though. This machine can run with 
the best of them. But it might be 
best suited to media lovers.

The crucial thing the T300 Chi 
gets right is it looks and feels like  
a traditional laptop. It’s well 
balanced, despite the tablet 
portion being slightly heavier and 
thicker than its keyboard base.

Beyond aesthetics, using the 
T300 Chi feels as natural as any 
laptop. You can easily place it on 
your lap and type away without it 
teetering backwards from the extra 
weight of the screen. Plus, it folds 
into a thin 16mm package with the 
thickness of the tablet and 
keyboard combined.

Magnetic appeal
To get the machine to such  
a thin profile, Asus used rare earth 
magnets to keep the two parts 
together. By doing so, it avoids a 
bulky locking mechanism. 
Although the tablet and keyboard 
sections aren’t locked with a hard 
connection, the magnets feel more 
than secure. You can easily lift the 
laptop by the keyboard, turn it 
upside down and give it a shake 
without the screen slipping.

However, that’s not to say they’re 
inseparable, either. With a quick 
tug, the screen will come away 
from the keyboard base. Slipping 

the display back on is simple,  
but you will have to make sure it’s 
lined up correctly.

The laptop itself is pretty smart, 
too. It’s made entirely out of 
aluminium anodised with a 
sparkling deep-blue finish. The 
machine also has chamfered, 
‘diamond cut’ edges on the outside 
edge of the keyboard deck, the 
inside track around the trackpad 
and around the perimeter of the 
screen lid. They’re a nice touch, 
especially for resting wrists on a 
softer front edge of the palm rest.

Of course, such a thin form 
introduces compromises, and this 
machine only has micro size ports. 
You’ll find a micro USB 3.0 port, 
micro HDMI and a microSD card 
slot on the bottom edge – even the 
Bluetooth keyboard features a mini 
USB charging port.

If you’re planning on plugging 
anything into this laptop, be 
prepared to use an adapter or some 
extra cables. Luckily, Asus includes 

Asus Transformer Book T300 Chi
£601 | $899 www.asus.com

The 2-in-1 machine that takes skinny to a whole new level
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though, filling a room with 
booming explosions from action 
films for instance.

The T300 Chi comes loaded with 
bloatware. All the usual suspects 
are here, including McAfee 
LiveSafe, Line, Music Maker Jam, 
Wild Tangent Games and Zinio. 
That said, there are a few 
applications you’ll want to keep 
around. Asus Splendid Utility is a 
software tool that optimises your 
viewing experience with different 
levels for colour saturation. Manual 
mode allows complete 
customisation including colour 
gamut, skin tones, sharpness, 
contrast and colour temperature. 
AudioWizard is ASUS’s software 
designed to enhance audio 
experiences, offering five intuitive 
presets: Music, Movie, Recording, 
Gaming and Speech Mode.

The final verdict
There are a few things Asus didn’t 
get right with the T300 Chi,  but it 
excels as a machine for multimedia 
consumption. It comes with a 
colourful, 16:9 display to kick back 
with and watch streamed films. At 
the same time, this is a pretty good 
device to read comics and books 
through the Kindle app, even if the 
app has not been optimised for 
high-resolution screens. ■

If you seek a premium machine  
to stream films and games, the 
T300 Chi has your number.

a mini USB 2.0 to the full-size port 
adapter. However, if you want to 
fully use USB 3.0 port, you’ll need  
to buy a micro USB 3.0 dongle.

Considering its price, the T300 
Chi comes well equipped, with the 
exception of the paltry 128GB of 
SSD storage. Sadly there’s no way 
of increasing the onboard storage 
(either with Asus or doing it 
yourself). One solution is to have a 
microSD card slotted in at all times. 

Screenless wonder
The Asus T300 Chi kept up with 
every task we threw at it, whether it 
was editing images in Lightroom or 
streaming a 4K video on YouTube. 
Thanks to its design as a tablet and 

laptop in tandem, you could 
quickly go from watching a Netflix 
film to typing up a document, and 
then pulling the screen off its base 
for a quick bit of gaming.

The detachable keyboard can be 
used even when not attached, 
thanks to the Bluetooth connection 
and its own battery. The keyboard 
is excellent, with tactile, clicky keys 
and a solid base that shows 
minimal flex despite being so thin. 
The trackpad, on the other hand, 
feels annoyingly sticky but it’s still 
serviceable enough. Plus, there’s 
always the option of tapping 
around with the touchscreen. It 
does make us wish the tablet came 
with a stand though, to make it 
more practical and stable.

Asus promises the keyboard on 
its own will have 84 hours of use a 

week on standby time. Sadly, 
though, the tablet end of this 
device can’t siphon power from  
a Bluetooth accessory.

Asus advertised the T300 Chi 
with an eight-hour battery life. Our 
experience showed it to be around 
half this, after a mix of web 
browsing, streaming Netflix for an 
hour, playing games, playing 
Google Music over the speakers set 
to 20 per cent and keeping the 
display to 50 per cent brightness. 
With just simple web browsing and 
word processing, we could 
probably get six hours. 

The WQHD, or 2,560 x 1,440, 
resolution display on the T300 Chi 
is magnificent. Everything you look 

at on it is stunningly sharp and 
clear with great contrast to boot.  
If you’re a fan of long vistas or 
looking at any type of colour 
photography and video, this screen 
will make it sparkle into life. 

Glaringly obvious
For production means, this panel  
is too colour rich, as reds can look 
overblown and meld into 
themselves. There’s the option of 
diving into Asus’s Splendid utility to 
manage your display options, but 
you’ll never be able to fix the 
screen’s other issue: glare. The T300 
Chi’s display panel is very reflective.

We weren’t impressed with the 
side firing speakers either. As 
expected on such a thin machine, 
they’re underpowered and tinny 
sounding. They can get loud 

“The Asus T300 Chi kept up with every task we 
threw at it, whether it was editing images in 
Lightroom or streaming a 4K video on YouTube”

Upgrade 
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KEY FEATURES

Asus Transformer Book 
T300 Chi
Manufacturer Asus
Processor 1.2GHz Intel Core M 5Y71 
processor (dual-core, 4MB cache, up to 
2.9GHz with turbo boost)
Storage 128GB SSD
Ram 8GB DDR3L (1600MHz)
Graphics Intel HD Graphics 5300
Connectivity Intel Dual Band Wireless-N 
7265 + Bluetooth 4.0 LE, micro USB 3.0, 
mini HDMI, microSD card reader, 
headphone/mic combo jack
Weight 3.14 lbs
Size 12.5 x 7.5 x 0.65in
Screen 12.5in
Resolution 2,560 x 1,440 (WQHD) 
capacitive multi-touch IPS display
Camera 2MP 720p webcam
Screen size 12.5in
Display resolution 1920 x 1080 Full HD



Many of us buy USB drives 
more often than we should 
because we’re always losing 

them. Or, we’ll buy a new one for 
newer technology – did you ditch 
your USB 1.0 sticks when USB 2.0 
gadgets came out? Well, we’re now 
starting towards USB 3.0… 
However, it’s now time to break the 
habit, as there’s a wonderful glitch 
in the path: the SanDisk Connect 
Wireless Flash Drive.

The lengthily named SanDisk 
Connect Wireless Flash Drive allows 
you to share content anywhere,  
to any device, with or without an 
existing Wi-Fi source.

 
The cost of sharing
 The 16GB drive is priced at around 
£40, the 32GB model around £50 
and the 64GB drive around £68.
The price points are high (£40 for  
a 16GB flash drive when you can 
buy a standard 16GB USB 3.0 stick 
for far less than that). But then you 
won’t have the excellent 

functionality that SanDisk 
incorporates into the Connect 
Wireless Flash Drive.

Flash in the pan
The Connect Wireless Flash Drive 
looks and feels like a normal-sized 
USB flash drive (okay, maybe it’s  
just a touch bigger). 

The system requirements call  
for a USB 2.0 interface or higher, 
though what type of USB 
connection the device uses isn’t 
specified. In terms of operating 
systems, this SanDisk device works 
well with Windows Vista, 7 and 8. 
It’s also allows for an optional 
password to be set for the Wi-Fi.

When it comes to sharing files, 
the drive works with almost all 
mobile devices. It supports Android 
devices on version 2.3 and later  
(as well as the Kindle Fire).

Charging the drive is carried out 
via a USB port on your computer,  
or you can use a charger. However, 
it’s important to note that it 

requires two hours of charging 
before the Wi-Fi option will work. 
But regardless of waiting for Wi-Fi, 
the SanDisk stick will still function 
as a normal USB straight away.

The performance of the drive  
is as you would expect for a USB 
stick. The Read/Write performance 
is particularly good and you can 
easily copy stuff to the drive via  
USB very swiftly.

If you need this device to receive 
PDFs, spreadsheets and other office 
files you won’t have any problems. 
However, transferring bigger files, 
say a bunch of MP3s or a film, may 
take a while if you’re using USB 2.0, 
but will be quick on USB 3.0.

Wi-Fi lowdown
You’ll soon notice the Wi-Fi aspect 
of this device is a bit different. Press 
the Wi-Fi button until it blinks blue 
to activate the Wi-Fi on the drive. 
Once on, you can connect your 
mobile device or computer to the 
drive by selecting the pre-named 

SanDisk Connect Wireless Flash Drive
£40 | $50 www.sandisk.co.uk

An innovative USB stick with built-in Wi-Fi

84  |    |  June 2015



However, we disliked the 
web-based application for the 
Connect Wireless Flash Drive – it’s 
just not that great. It’s basic and we 
were hoping for something a lot 
more dynamic, in truth. 

Another flaw is the lack of active 
Wi-Fi while the USB drive is 
plugged into a computer charging. 
That just seems like a lack of 
planning on SanDisk’s part. 
Hopefully an upgrade will fix that.

 Overall, the SanDisk Connect 
Wireless Flash Drive is excellent. 
The Wi-Fi capability may seem like 
a gimmick but its real-world uses 
are endless. If nothing else, this is a 
USB drive that offers another way 
of easily sharing your content with 
collaborators when all other means 
fail. And that could be a very handy 
feature to have on tap. ■

A great gadget for those who 
work on the go or if you simply 
want more out of a USB stick.

wireless name. On a Windows 
machine, you can connect to the 
drive via a web browser.

The directions to hook up with a 
web browser instruct you to 
connect to sandisk.com/WFD. 
However, we found that doesn’t 
always work consistently. 

You can try using your IP address 
of the SanDisk drive in the web 
browser (which can be found in 
your network adapter’s  
IP settings, then point your browser 
to the information under the 
‘gateway’ setting). Usage via the 
web browser is merely okay – it  
just lists files in a basic directory. 
But it works.

For mobile devices you can 
download the SanDisk Wireless 
Flash Drive app. Once downloaded, 
connect your Android device to the 
SanDisk Connect Wireless Flash 
Drive’s Wi-Fi and that’s it.

The mobile app is far better than 
the web-browser app. You can 
change the Wi-Fi (SSID) name, 
password and energy-saver 
settings on both the web and 

mobile apps. The web platform 
allows you to change the Wi-Fi 
Channel of the drive, and the 
mobile app lets you add the 
SanDisk device to an already 
existing Wi-Fi access point. So, if 
you want your drive to connect 
directly to your home network, 

then you would set this here. The 
mobile app also allows you to 
upload contacts and other files, 
along with the facility to download 
files to your device.

Another thing worth mentioning 
is the Wi-Fi battery life is pretty 
decent. We put a film on the drive 
and streamed it to our mobile 
phone – the SanDisk device lasted 
for 55 minutes before giving out.

Final verdict
The SanDisk Connect Wireless Flash 
Drive makes things easy – the Wi-Fi 
aspect is extremely clever and it 
works well. This device is ideal if 
you frequently collaborate with 
friends and co-workers in locations 
where Wi-Fi is not available, such as 
when travelling.

“The Wi-Fi capability may seem like a gimmick,  
but its real-world uses are endless”

Upgrade 
SanDisk Connect Wireless Flash Drive
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KEY FEATURES

SanDisk Connect Wireless 
Flash Drive
Manufacturer SanDisck 
System Requirements USB 2.0 
connection interface or higher 
For mobile devices Android version 2.3 
or higher, iOS version 5.0 or higher 
For other Wi-Fi enabled devices  
A web browser 
PC Windows 8, Windows 7, Windows 
Vista, Windows XP 
Available capacities 16GB, 32GB 
and 64GB 
Dimensions 70.9 x 21.3 x 11.4mm



Fitbit Surge is a fitness tracker 
that’s big on features. The 
start-up company behind it 

calls it a ‘superwatch’, compared to 
its Fitbit Charge and Fitbit Charge 
HR, and it boasts built-in GPS, a 
heart-rate monitor and real-time 
workout data.

 The Fitbit Surge fastens a large 
LCD display to your wrist, and it’s 
able to easily cycle through 
multiple stats. This backlit, always-
on interface allows you to keep 
tabs on your steps, miles, active 
minutes and heart rate on a 
black-and-white, 1.25-inch screen.

The device boasts a touchscreen, 
and also puts three physical 
buttons at your fingertips, so you 
can control workout timers, GPS 
tracking, your music and more.

It would’ve been practical if there 
was an option to cycle back to the 
current time after a while. We also 
missed not having additional watch 
faces to supplement the 
preinstalled four.

Tucked underneath the watch’s 
band is an optical heart-rate 
monitor and, at ends of the straps, 
a strong wristwatch clasp.

While the Fitbit Surge 
functionality is advanced, the 
square look and bigger size looks 
like it belongs to a retro 80s digital 
watch. It’s not fashionable. And it 
doesn’t help that it only comes in 
black, with blue and tangerine 
“coming soon”.

Lug your workout 
At its thickest point, the watch case 
is half an inch thick off the wrist and 
its strap an inch wide. The large, 
rubber-coated lugs at the top and 
bottom make tucking it neatly 
under a buttoned cuff a workout in 
itself – not ideal for everyday wear.

Fitbit Surge has eight sensors 
crammed into its large frame, 
which, along with the LCD 
touchscreen, accounts for its size. 
This means it can track all sort of 
movements. There’s an altimeter, 

for example. The GPS maps your 
runs using Google Maps while 
generating step-by-step graphs for 
elevation, pace, heart rate and 
calories burned.

Fitbit Surge’s satellite tracking 
works without your phone. It’s 
motivating – review your run, 
seeing it laid out on a familiar 
overhead map. Though the 
tracking isn’t always accurate, with 
occasional off-track routes a street 
and a half over. Though these errors 
are few and far between. Run 
tracking can be initiated right from 
the watch, with or without GPS.

Exercise shortcuts include 
weights, elliptical, spinning, yoga, 
workout, stair climber, circuit 
training, bootcamp, kickboxing, 
tennis, golf, walking, cycling and, 
even martial arts. The app also has 
a menu for food planning, but it’s 
cumbersome to track.

Coupled with the runner-friendly 
GPS feature, the Fitbit Surge has a 
heart-rate monitor that constantly 

Fitbit Surge
£200 | $250 www.fitbit.com

The all-singing, all-dancing (and somewhat chunky) superwatch
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Fitbit Surge excels in a lot of 
areas, but falls behind its 
predecessors when it comes to 
battery life. That’s expected given 
its large black-and-white LCD and 
new GPS capabilities. However, 
Fitbit promises its new ‘superwatch’ 
can last seven days with heart-rate 
monitoring and activity tracking 
enabled. But it does advise turning 
off GPS and music controls.

Our Surge gave us about four 
and a half days between charges, 
even with minimal GPS usage. But 
then most Android Wear watches 
(and our phones) require daily 
charging. It takes about an hour 
and a half to recharge a Surge. 

Surge of power
This is the most powerful Fitbit yet. 
It’s the best of its brand, thanks to 
the ability to track GPS-mapped 
runs without a phone, control music 
on the run and check your heart 
rate in real time.

But best of all, it syncs with 
newer Windows phones in addition 
to Android devices.

The downside is Fitbit Surge tries 
to be a jack-of-all-trades… but falls 
short and ends up being a master 
of none. It’s not always accurate 
and it’s really not subtle as an 
activity band. However, this gadget 
is meant for budget-conscious 
power users who are in need of a 
smarter running accessory. Fitbit 
Surge is set up to fill the void 
between a fitness tracker and a real 
running watch.

The most powerful Fitbit to date 
– the superwatch is big on 
features, size and price.

tracks heartbeat. Really, it’s an 
optical heart rate monitor that sits 
on the underside of the watch and 
reflects a pair of green LEDs off 
your skin to calculate changes in 
blood volume. This technology is 
no different to the Fitbit Charge HR. 
But the Surge does have a helpful 
trailing BPM indicator on the LCD.

Sleep on it
Another feature is automatic sleep 
detection, so you don’t have to 
change mode. And it starts logging 
sleep within minutes of dozing off. 

The only thing you need to set is 
the convenient silent alarm that 
vibrates to wake you and not the 
person next to you.

The sleep timeline was basic: 
asleep in blue, restless in aqua and 
awake in pink. It was also hard to 
read, so the automatic sleep 
detection is less meaningful. The 
sleep tracking is a fantastic idea,  
so it’s a shame it doesn’t follow 
through with anything that can be 
considered accurate or helpful.

The Surge shows off scrolling 
Caller ID from incoming calls and 
SMS alerts that can be read in full, 
so you can see if a call or text is 
worth disturbing your run for.

A double tap on the left button 
brings up a hidden menu for 
controlling with your phone’s 

music. We used Google Play Music 
and could skip tracks, pause and 
play music. Music playback requires 
enabling Bluetooth Classic, which 
was confusing at first and drains 
the battery quickly. But it was 
effective once we re-synced the 
watch to our phone.

Chances are, if you own a 
modern day smartphone, Fitbit 
Surge works with it. The necessary 
app is compatible with iOS 8, 
Android and Windows Phone.

Fitbit is the first mainstream 
wearable manufacturer to invite 

Microsoft’s loyal customers into  
the fitness stats-syncing fold,  
and it goes a step further on 
Windows Phone 8.1. 

Wet workout
The Surge is as waterproof as a 
smartwatch gets and according to 
the official specs it’s good for a 
depth of 50 metres. However, 
confusingly, the company still says 
while “it’s rain and splashproof and 
can stand up to the sweatiest 
workout,” owners should “remove 
before showering or swimming”. 

To test this out we submerged 
the Fitbit Surge for a few minutes… 
And we found it was absolutely 
fine, and so will almost certainly 
survive lengthy, sweat-filled 
workouts or heavy rain.

“Fitbit Surge is set up to fill the void between  
a fitness tracker and a real running watch”

Upgrade 
Fitbit Surge
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KEY FEATURES

Fitbit Surge
Manufacturer Fitbit
Sensors and components GPS, 3-axis 
accelerometers, 3-axis gyroscope,  
digital compass, optical heart rate 
monitor, altimeter, ambient light sensor, 
vibration motor
Requirements Windows Vista and later, 
internet connection, USB port
Connectivity Bluetooth 4.0
Display Touchscreen monochrome LCD 
with backlight (for low light visibility)
Water resistance To 5 ATM
Battery life Up to five days
Battery type Lithium-polymer
Charge time One to two hours 



Evolve’s general visuals are just as 
arresting as the cutscenes

pace instills a feeling of 
constant urgency, but also 
makes it more fleeting than 
other multiplayer games out 
there. The four-versus-one 
format is exactly the sort of 
asymmetry we need more of 
in the genre, but we’ve rarely 
ended up with war stories 
we’re gagging to share

Unlike Evolve‘s zombie 
ancestor, though, it’s a 
fleshed-out competitive game, 
and the most ambitiously 
uneven entry in the genre 
since Rising Storm. Its dozen 
Hunters – three for each of its 
four classes, with more on the 
way as paid DLC – form a 
spectrum of interesting 

playstyles. Bucket, one of the 
Supports, unscrews his robot 
head and spits out guided 
missiles, while Lazarus is a 
medic who lets teammates die 
before healing them. The 
variety is vast.

Sci-fi safari
And along those lines, these 
weapons and abilities have 
their own specific skills. 
Developer Turtle Rock extends 
that “easy to learn, hard to 
master” virtue across most of 
the experience and Evolve 
benefits immensely. On both 
the monster and Hunter sides 
there’s a focus on cooldown 
management that we like. The 

Evolve is a jetpack dance 
between prey and 
predator, a multiplayer 
tango with ever-shifting 

positions. In a typical round, 
you go from being a frag god 
to fragile and back again in 
about 12 minutes. One 
moment you’re a firebreathing 
Goliath, the next you’re a 
fleeing, crumpled heap, 
scraping the map for alien 
wildlife to keep you going.

Evolve‘s rhythm differs 
between map and mode, but 
it’s generally the tightest FPS 
multiplayer since Titanfall. For 
the four Hunters it’s all about 
pursuit, with little time to plot, 
joke or catch your breath. That 

A crossbreed of co-op and competitive FPS
Price £40 | $60
Developer Turtle Rock Studios
Publisher 2K Games  
Multiplayer 2-5 player co-op competitive modes, or solo, or 1-4 players against bots 
DRM Steam Web www.evolvegame.com
Recommended specs Windows 7 64-bit, Core i7-920, 6GB RAM, Nvidia GeForce GTX 670/ATI Radeon R9 280

Evolve Hunters’ jetpacks always feel 
starved – knowing when to 
conserve juice as you’re trying 
to keep up with a beast who’s 
straight-up quicker creates an 
interesting tug-of-war.

The monsters have their 
share of tough-but-fun 
movement techniques to 
master too. Paranoia 
permeates everything and 
that fear drives you to do 
anything you can to shave 
seconds off your traversal 
time. The trickier skill is stealth 
– successfully sneaking your 
way through a Hunt round 
makes you feel like a two-
storey-tall ninja.

The Wraith became our 
favourite of Evolve‘s aliens. Her 
movement style (hovering and 
lunging) and fragility 
encourages hit-and-run 
tactics. We loved frustrating 
Hunters with the decoy ability, 
which spawns an AI-controlled 
mirror-Wraith – they find it 
brilliantly annoying. 

The game is best in 
Evacuation, where a group 
plays five successive rounds on 
a mix of maps and modes. This 
format doesn’t address the 
game’s briefness, but it does 
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That is one angry, ugly  
bullfrog – let’s call him Peter…

The dozen Hunters offer an 
impressive array of playstyles

The Wraith is a treat for  
players fond of trickery

form a bit of history between 
players and creates the 
opportunity for comebacks.

Other than Hunt, the  
three other modes within 
Evacuation do an okay job of 
stimulating different playing 
styles. Nest, where the Hunters 
have to destroy six monster 
eggs, is probably best. The 
Hunters must decide if, when, 
and how much to split up, a 
manoeuvre that makes them 
more vulnerable but means 
they’ll succeed quicker. 
Despite their simplicity, Nest, 
Rescue and Defend have some 
good tactical wrinkles, but 
there are also moments when 
they feel mundane. The 
objectives don’t generate fun 
in isolation – they rely on the 
monster stirring up trouble.

Evolve also leans heavily on 
its matchmaking system. It 
takes coordinated Hunters to 
keep pace with an 
experienced monster, or a 
clever monster to challenge 
Hunters who know every trick. 
Most of our solo matches put 
us in satisfyingly tough games 
– nearly every time it felt like 
we were being exposed to 
new tactics. 

We had a worse time with 
players of mixed skill levels. 
That isn’t a fault of the 
matchmaking – Evolve‘s 
balance is such that a Hunter 
team is only as strong as its 
least agile member, something 
to take into account if you’re 
playing with friends. 

Luckily, this is less of an issue 
in Evacuation, which balances 
the match over time. If you 
continue to lose, you’ll get 
stronger. The competitive 
purist won’t be wild about the 
idea, but it does make 
one-sided shutouts unlikely. 
Also, you can disable it by 
creating a custom match. 

Our feelings about Evolve‘s 
16 maps are mixed. They’re 
well-designed, spacious 
arenas, but they’re also 
surprisingly homogeneous. 
The few map-specific features 
within them don’t prompt 
different playstyles, something 
that will erode replay value. 

Multiplayer mayhem
A couple of other aspects of 
Evolve‘s multiplayer structure 
undermine its appeal. 
Evacuation’s voting system is 
odd. Between each round, the 

four Hunters and monster cast 
votes on potential 
combinations of map and 
mode. But it’s an illusion of 
democracy as the Hunters 
always have a majority.

More frustrating is how 
easy it is for players to leave a 
match. The penalty is a 
60-second timeout. Likewise, 
if one of your friends crashes, 
their spot in that match isn’t 
reserved. On the upside, 
when the AI tags in, it’s 
usually competent enough to 
not get you killed, but it lacks 
the creativity to take 
advantage of Evolve‘s weird 
weapons and abilities. 

Given how much of your 
time is spent chasing, it’s 
appropriate that a night of 
playing feels like a series of 
sprints. If you lose, a rematch is 
a 10-minute proposition, 
something that 
counterbalances Evolve‘s 
intensity. But after unlocking 
everything we’re less 
motivated to keep playing. We 
wish Turtle Rock would’ve 
doubled-down and built a 
bespoke ranking system like 
that of League of Legends or 
StarCraft 2. 

Evolve certainly has the 
depth to support such a 
system. Its emphasis on skillful 
movement and out-
manoeuvring your opponent 
are unique. The Hunters and 
monsters have some of the 
most elegant, simple-but-
deep mechanics we’ve laid 
hands on. And it’s one of the 
best-looking games on PC, 
blessed with splashy particle 
effects, smart UI, and monsters 
worthy of Pacific Rim. But 
we’re concerned about its 
longevity. It has tons of 
novelty, but without maps that 
bolster its replay value we 
worry about how well Evolve’s 
paid DLC and planned free 
map releases will keep pace 
with players’ fatigue. ■

A refreshingly
asymmetrical FPS with
terrific competitive depth.
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spraying through corridors. 
The ballistics aren’t very 
interesting but the 
animations and sounds are 
addictive. There’s even a 
beam weapon – like a 
Ghostbusters proton pack, 
only it extracts ghosts from 
the living.

You’ll be a walking, 
running, jet-jumping 
massacre, then, but all that 
power is constricted by a 
greater power: the script. 
There are moments when 
Advanced Warfare snaps the 
rigidity typical of CoD 
campaigns – a brief, 
unguided stealth section and 
a grappling hook that you 
can occasionally use freely – 
but outside of that you’ll 

rarely be asked to solve any 
problem, other than who to 
shoot first. 

AW’s eight-hour campaign 
was hard to put down, 
though. With the help of 
Kevin Spacey in a lead role, it 
tells a simple, predictable 
story of power and 
corruption. You might  
not care much for it, but it’s 
an effective way to push 
players into increasingly 
improbable scenarios: 
hopping between buses on 
a freeway, clinging to a jet 
with magnetic gloves as it 
flew over Antarctica, 
speeding away from 
assailants on a hover bike. It’s 
impossible to become even 
remotely bored when you’re 

Call of Duty: Advanced 
Warfare’s campaign is 
a first-person shooting 
gallery smattered with 

nearly-on-rails vehicle 
segments, quicktime events, 
and slightly interactive 
storytelling. Just like  
the other CoD games, then.

It’s a lot better than Ghosts, 
though, and it introduces 
some neat near-future 
gadgets. The most 
interesting are the Exo  
suits, which imbue their 
wearers with double-jumps, 
strafe dashes, and other 
special abilities.

Guns are everywhere: big, 
powerful, varied, some 
punching single shots 
through armour, others 

A futuristic but familiar military shooter drones on
Price £40 
Developer Sledgehammer Games, Raven Software
Publisher Activision  
Multiplayer 4-12 player online competitive and ‘horde’ style co-op  DRM Steam Web www.callofduty.com
Recommended specs Core i7-4770K, 16GB RAM, GTX Titan Black

Call of Duty:  
Advanced Warfare

doing something new, 
extravagant and adventurous 
every ten minutes.

Looking good
Despite a few ugly textures, 
this is by far the best-looking 
CoD too. The Antarctica level 
in particular is gorgeous, 
with glowing ice caves and 
great windy plains of snow. 
Our biggest complaint is that 
Warfare slacks on some of 
the basics. We were always 
faster than the squadmates 
we were supposed to follow, 
and always reached our 
destination first. They 
gestured to us over their 
shoulders while we were 
standing in front of them, 
then barked at us to open 

 Two-on-one situations in  
 multiplayer rarely end well 
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the door we’d been standing 
next to the whole time. Also, 
we got stuck in the geometry 
once while under attack from 
a sniper… and so on.

The story conclusion didn’t 
particularly feel fulfilling. 
Kevin Spacey’s performance 
was good, but we didn’t 
grow attached to any of the 
characters, or give a damn 
about who survived. 

Enhanced warfare
AW’s multiplayer is much 
better than Ghosts’, too. 
The weapons are more 
fun to handle, the maps 
more colourful, interesting 
and better designed, and 
the progression system 
far superior.

The Exo suits, with their 
jet-assisted double jump, 
are useful for getting to the 
high ground in a hurry, and 

occasionally for getting out 
of fire through a high jump. 
They do make for fun 
cat-and-mouse chases. They 
also have special abilities, 
such as cloaking and 
hovering. These are unlocked 
along with special grenades 
and weapon attachments as 
you earn experience and 
ranks – as usual.

New equipment, however, 
is now also unlocked in 
‘supply drops’ acquired 
during matches. Like a Team 
Fortress 2 crate, these gift you 
surprise new guns and gear.

We like that we can 
customise the look of our 
soldier. More importantly, 
there are now weapon 
variants to collect, so while 
there are only six assault 
rifles, for instance, there are 
multiple versions of each. 
The guns have plenty of 

variety on offer, though 
some feel superfluous. 

A big complaint about  
all the guns is that, while 
getting used to their stats 
and bullet spread is 
interesting, their animations 
are dull and simple, and 
there aren’t many moving 
parts. They do have distinct 
personalities, it’s just hard to 
see it.

Warfare still doesn’t rank 
particularly highly for us, 
especially when compared to 
other multiplayer shooters. 
Rising Storm has fidelity, and 
generates the best stories, 
CS:GO offers tension and 
nuanced tactics, Titanfall is 
great casual fun, and Team 
Fortress 2 has the best 
community. CoD remains a 
churning sea of adolescent 
sharks for whom new players 
are chum. The first several 

hours of learning are 
frustrating, so thank 
goodness for the new 
Combat Readiness Program, 
which is a silly but sweet way 
to learn anonymously with 
other beginners while you 
learn the ropes. 

Even though there’s 
nothing particularly new or 
challenging here, the fun 
comes with the familiarity of 
what you already know. ■

Predictable and fun, but  
still has some of the  
familiar shortcomings.

 Did they mention Kevin 
Spacey is in it? Kevin Spacey. 
Kevin Spacey 

 Things get pretty dark… 

 The ice caves look amazing  Yep, you fly a jet. The WASD 
controls  are atrocious, so it’s 

best that it’s brief 

 Experimenting with guns and 
 scopes is a lot of CoD’s draw 

Upgrade 
Play this…
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the shoot is plugged in and 
starts taking up the energy 
the main plant needs, it 
pulses a few times.

It’s very easy to get 
incredibly involved in the 
fiction in this game, as well 
as get busy planning what 
connections to make for the 
most economical climb.  
You’ll find yourself winding 
shoots in all directions, 
around each other, doubling 
back to sprout an offshoot 
from an offshoot, and when 
you look down through the 
polygonal clouds you’ll see a 
beautiful tangled maze of 
your own creation.

Exploration time
It should only take a couple 
of hours to make the star 

plant flower, but Grow Home 
has a great pace. 
Shortly after BUD lands, 
you’re taught the grab 
mechanic that’s used for 
almost every action in the 
game, including climbing, 
and directed to use it to 
retrieve a gem. Collecting 
these gems unlocks abilities, 
the second of which is the 
ability to zoom out the 
camera and should become 
available around when the 
world starts to open up.

These gems also  
encourage the more 
horizontal exploration that 
supplements your vertical 
climb. After every few energy 
rocks your star plant will 
break through a kind of 
landmark, perhaps a floating 

You’re a red robot 
called BUD, on a 
low-poly planet with 
low-poly flora, fauna 

and floating islands. Your 
task, as explained by MOM 
– a ship’s computer that 
watches over BUD while 
cracking jokes – is to 
encourage a giant star plant 
to grow until it flowers and 
produces seeds to take back 
home. Got it?

To make the star plant 
grow, BUD has to climb it 
until he finds a smaller 
offshoot, which he then rides 
on as it reaches for a floating 
glowing energy rock. You aim 
these shoots but they also 
have a mind of their own and 
struggle against your 
direction. And finally, when 

A small game with big dreams
Price £6 | $8
Developer Ubisoft Reflections
Publisher Ubisoft  
MultiplayerNone  DRM Steam 
Web www.ubisoft.com/en-GB/game/grow-home

Grow Home island with a prominent 
waterfall. We were generally 
glad of the opportunity to 
take a break for some more 
traditional platforming.

You control BUD’s hands 
separately, one for each 
bumper/trigger (you’ll want 
to use a gamepad, trust us), 
and when climbing his body 
dangles between them. BUD 
might not feel the strain, but 
after only a couple of hours 
my wrists did, especially since 
the same grab mechanic is 
also used to collect gems, to 
gather the flowers and leaves 
BUD can use as parachutes, 
and to torment wildlife.

But even if your wrists are 
throbbing, you’ll be glad of 
the extra mission that gives 
you the excuse to go explore 
more. Thanks, MOM. ■

A unique and charming 
game, worth the few quid 
and few hours it needs.

Teleporters are useful for quickly 
transporting BUD and wildlife

Autumn leaves make
 useful parachutes

BUD the explorer  
goes on the hunt

These are fungis 
to hang out with
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Rainbow deer in knee-high socks 
was a little too precious

Once in a while  
you’ll also see a 

random element

From this distance, Gravity 
Ghost looks good enough... 

fire, etc – so you can transform 
planets, and a movement 
ability makes jumping 
between them easier and 
more fun. You can gain the 
ability to jump mid-air, hover 
mid-air, and descend more 
quickly as if cannonballing  
into a pool. 

However, there’s more to 
Gravity Ghost than flinging 
yourself around planets, you 
can also turn solid planets into 
water planets and then swim 
through them. And don’t 
worry about the puzzles that 
require you to slow down and 
think about transforming 
planets. It will put you into the 
level you need to gather 
enough momentum to smash 
through glass planets, or one 
where you can chase down a 

spirit animal that mirrors your 
movements. There’s plenty 
going on here.

The only notable issue is 
that there’s something 
confusing about controlling a 
character whose up and down 
are constantly shifting. We got 
used to it after a while, but we 
continued to mess up jumps 
until the very end.

A puzzling time
Instead of the standard boss 
fight, each constellation  
ends with a unique, more 
elaborate puzzle, such as the 
one that required us to rotate 
around a planet to move 
different coloured shadows of 
a fox until they overlapped 
and created purple and 
orange foxes. 

Gravity Ghost starts out 
simple enough. You 
jump from planet to 
planet, using the gravity 

to launch into 2D orbits so 
you’re within reach of the star 
you need to collect in every 
level. We’ve seen this kind of 
thing before, but Gravity Ghost 
does it better and without 
shotguns. And it even finds 
time to explore more 
complicated puzzles and an 
unconventional story. 

A lot of what makes this 
game work is its pacing, which 
will keep you playing through 
in one sitting. You choose 
levels from a map divided into 
hubs, or constellations, which 
are unlocked by collecting 
more stars. Each constellation 
adds a new element – water, 

A pretty 2D platformer, with pretty fine gameplay
Price £11 | $15
Developer Ivy Games LLC
Publisher In-house  
Multiplayer None  DRM Steam Web www.gravityghost.com
Reviewed on AMD Quad Core 3.3GHz, 16GBRAM, GeForce GTX 660 Ti

Gravity Ghost At this point you’ve 
probably noticed Gravity Ghost 
has some cute animals in it. 
There’s also a frog, a deer, and 
a bird that leaves a trail of 
pretty flowers. But even 
though, there’s something 
about Gravity Ghost’s particular 
aesthetic that’s twee, it 
actually gets pretty dark 
towards the end, where it 
reveals how all these animals 
and repeated symbols fit 
together, and it’s a powerful 
and melancholy moment. 

For all the love that we 
could see was put into it, 
Gravity Ghost’s story  
ultimately feels slightly  
stilted. But still we loved its 
ambition, and it’s otherwise  
a novel, excellently paced,  
and consistently clever 
puzzle-platformer. ■

Hits the notes of bigger  
platformers on a smaller  
(and sweeter) scale.
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From £9.99
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how to...
●  Work with Microsoft 

Office documents
● Create Mind Maps
●  Uninstall programs

speed up 
windows 8.1! 
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– simply get 
more speed 
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